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Preface

Welcome to Hyperion Analyzer Getting Started. This preface discusses the 
following topics:

● “Purpose” on page xi

● “Audience” on page xi

● “Document Structure” on page xi

● “Where to Find Documentation” on page xii

● “Conventions” on page xiv

● “Additional Support” on page xvi

Purpose
This guide assists new users in understanding and using the Hyperion Analyzer 
Java Web Client and Hyperion Analyzer HTML Web Client.

Audience
Although this guide is intended to help new users learn about Hyperion Analyzer 
quickly, every user can benefit from the feature descriptions and conceptual 
information. 

Document Structure
This document contains the following information: 

Chapter 1, “About Hyperion Analyzer,” introduces Hyperion Analyzer and the 
main user types.
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Chapter 2, “Overview of Multidimensional Analysis,” gives a brief overview of 
multidimensional analysis.

Chapter 3, “Hyperion Analyzer Java Web Client Interface,” describes the 
Hyperion Analyzer Java Web Client user interface.

Chapter 4, “Using the Java Web Client,” describes how to open, format, save, and 
distribute Hyperion Analyzer Reports

Chapter 5, “Hyperion Analyzer HTML Web Client Interface,” describes the 
Hyperion Analyzer HTML Web Client user interface.

Chapter 6, “Using the HTML Web Client,” describes how to open, format, save, 
and distribute using the robust thin client.

Chapter 7, “Touring the Sample Report Group,” guides you through a set of fully 
functional reports and identifies product features you may want to leverage in you 
own reports.

Chapter 8, “Creating Your First Report,” guides you through the process of 
creating a simple Hyperion Analyzer report.

Chapter 9, “Creating a Dynamic Custom Report,” guides you through the process 
of creating an advanced custom report in Design Report mode.

Chapter 10, “Overview of Advanced Features,” describes many more advanced 
product features available in Hyperion Analyzer.

Glossary contains a list of key terms and their definitions.

Index contains a list of Hyperion Analyzer terms and their page references.

Where to Find Documentation
All Hyperion Analyzer documentation is accessible from the following locations:

● The HTML Information Map can be accessed by starting any Hyperion 
Analyzer client and selecting Information Map from the Help button or from 
the Help menu command. 

● Online help is accessible from the component that it documents. Start the 
product and click the Help button or menu command.

● The Hyperion Solutions Web site is located at 
http://www.hyperion.com.

http://www.hyperion.com
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● Access to the Hyperion Download Center is through 
http://hyperion.subscribenet.com .

Available Documentation
The following documentation is included with Hyperion Analyzer.

● Information Map - Lists and describes all Hyperion Analyzer documentation 
and its location. 

● New Features - Describes all new features specific to this release of Hyperion 
Analyzer.

● Java Web Client Online Help - Provides detailed information about 
navigation, report creation and advanced Java Web Client topics.

● HTML Web Client Online Help - Provides detailed information about 
navigation, report creation and the features specific to the HTML Web Client.

● Installation Guide - Describes installation, migration, and installation options 
essential to installing and configuring Hyperion Analyzer. This guide includes 
procedures for establishing a Hyperion Analyzer repository, executing silent 
installations, and installing Hyperion Analyzer samples.

● Administrator's Guide - Describes installation, migration and product features 
essential to administrators. A profile of Hyperion Analyzer Administration 
Tools and the Hyperion Analyzer Analysis Server are included, as well as tips 
for configuring Hyperion Analyzer.

● Administration Tools Online Help - Explains the management of users, user 
groups, and database connections, as well as providing online help for 
Hyperion Analyzer Analysis Server administration. To access Administration 
Tools Online Help, start Hyperion Analyzer Administration Tools, and select 
Contents and Index from the Help button or Help menu command.

● Readme - Contains a comprehensive list of known issues, fixes and 
late-breaking product developments.

➤ To access the documentation from the Hyperion Solutions Web site:

1. Log on to http://www.hyperion.com.

2. Select Support from the menu bar.

http://www.hyperion.com
http://hyperion.subscribenet.com


xiv ■

Preface

Hyperion Analyzer Getting Started

3. Enter your username and password, and click Login. 

Tip: If you do not have a username and password, click Register on the login 
page to request them.

4. Select Software/Documentation.

5. From the Product list box, select Hyperion Analyzer.

6. From the Display list box, select Documentation, then click Submit. 

➤ To access documentation from the Hyperion Download Center:

1. Log on to http://hyperion.subscribenet.com .

2. In the Login ID and Password text boxes, enter your assigned login ID name 
and password, then click Login.

3. If you are a member on multiple Hyperion Download Center accounts, select 
the account that you want to use for the current session.

4. From the Product List, select Hyperion Analyzer.

5. In the New Releases tab, select 7.0.

Additional Documentation
In addition to the documentation for Hyperion Analyzer, you may want to refer to 
the following documentation:

● Hyperion Essbase Database Administrator’s Guide

● Operating system documentation set

● Relational database documentation set

Conventions
The following table shows the conventions used in this document: 

Table i: Conventions Used in This Document 

Item Meaning

Arrows indicate the beginning of a procedure consisting 
of sequential steps or one-step procedures.

http://hyperion.subscribenet.com
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Brackets [] In examples, brackets indicate that the enclosed elements 
are optional.

Bold Bold in procedural steps highlights major interface 
elements.

CAPITAL LETTERS Capital letters denote commands and various IDs. 
(Example: CLEARBLOCK command)

Ctrl + 0 Keystroke combinations shown with the plus sign (+) 
indicate that you should press the first key and hold it 
while you press the next key. Do not type the + sign.

Example text Courier font indicates that the material shown is a code or 
syntax example.

Courier italics Courier italic text indicates a variable field in command 
syntax. Substitute a value in place of the variable shown in 
Courier italics.

ARBORPATH When you see the environment variable ARBORPATH in 
italics, substitute the value of ARBORPATH from your site.

Italics Italics in a product-related term in the body of a book 
indicates that the term is also included in the glossary of 
the book.

n, x Italic n stands for a variable number; italic x can stand for 
a variable number or an alphabet. These variables are 
sometimes found in formulas.

Ellipses (...) Ellipsis points indicate that text has been omitted from an 
example.

Mouse orientation This document provides examples and procedures using 
a right-handed mouse. If you use a left-handed mouse, 
adjust the procedures accordingly.

Menu options Options in menus are shown in the following format. 
Substitute the appropriate option names in the 
placeholders, as indicated.

Menu name > Menu command > Extended menu 
command 

For example: 1. Select File > Desktop > Accounts. 

Table i: Conventions Used in This Document (Continued)

Item Meaning
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Additional Support
In addition to providing documentation and online help, Hyperion offers the 
following support for product information.

How to Order Printed Documentation
To order printed documentation: 

● Visit the Hyperion Solutions Web site at http://www.hyperion.com .

● In the United States, call Hyperion Solutions Customer Support at 
877-901-4975.

● From outside the United States, including Canada, call Hyperion Solutions 
Customer Support at 203-703-3600. Clients who are not serviced by support 
from North America should call their local support centers.

Education Services
Hyperion offers a variety of training options, including instructor-led training, 
custom training, and eTraining. This education covers all Hyperion applications 
and technologies and is geared to administrators, end users, and information 
systems (IS) professionals.

Instructor-led training is delivered in formats and in locations suited to Hyperion’s 
diverse, global customers. Hyperion Authorized Training Centers are certified to 
deliver courses developed by Hyperion. Custom Education Services—training on 
the configured and tailored applications that employees use on the job—is another 
option to enhance user productivity and to ensure smooth day-to-day operations. 
A service called eTraining—including computer-based training, Web-based 
training, and interactive Virtual Classroom training—provides a cost-effective 
means of giving users a hands-on introduction to product features and functions. 
Computer-based training (CBT) and Web-based training (WBT) provide 
high-quality, self-paced training at the user’s convenience, regardless of location.

For more information about training, contact your Regional Education Manager 
or visit the Hyperion Solutions Web site at http://www.hyperion.com to see 
a list of all training classes. 

http://www.hyperion.com
http://www.hyperion.com
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Consulting Services
Hyperion Consulting Services assists customers in maximizing the use of, and the 
return on investment in, Hyperion products. Experienced Hyperion consultants 
and Hyperion Alliance Partners assist organizations in tailoring solutions to their 
particular requirements, such as reporting, analysis, modeling, and planning. 
Specific services include implementation consulting, custom business solutions, 
data integration, and technical consulting. Additionally, Hyperion offers a variety 
of Services Packages and Reviews.

For more information about Consulting Services, Services Packages and 
Reviews, as well as the services offered by Alliance Partners, contact your local 
consulting services representative, or visit the Hyperion Solutions Web site at 
http://www.hyperion.com to see a list of all Hyperion Alliance Partners.

Technical Support
Hyperion provides Web-based and telephone support to ensure that clients resolve 
product issues quickly and accurately. This support is available for all Hyperion 
products at no additional cost to clients with a current maintenance agreement.

● For Web-based support, or to see complete information on 
available support options, visit the Hyperion Solutions Web site 
at http://www.hyperion.com.

● In the United States, call 877-901-4975 for Hyperion Solutions Customer 
Support.

● From outside the United States, including Canada, call Hyperion Solutions 
Customer Support at 203-703-3600. Clients who are not serviced by support 
from North America should call their local support centers. 

Documentation Feedback
Hyperion strives to provide complete and accurate documentation. We value 
your opinions on this documentation and want to hear from you. Send us your 
comments by completing the survey available at http://www.hyperion.com.

http://www.hyperion.com
http://www.hyperion.com
hyperion.com/customer_services/support_programs/doc_survey
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1

Chapter

1
About Hyperion Analyzer

Hyperion Analyzer enables organizations around the world to turn raw data into 
valuable business information.

With Hyperion Analyzer, you analyze sophisticated multidimensional and 
relational data in an easy-to-use graphical interface. This empowers you to explore 
enterprise data for growth and profit opportunities, uncover emerging problems, 
and test solutions before implementing them.

Hyperion Analyzer provides a set of advanced analysis tools and enables you to 
leverage Hyperion Essbase server features simultaneously. You can also retrieve 
and analyze Hyperion Financial Management and relational data using Hyperion 
Analyzer.

Analysis reports can be distributed internally and externally, saved as HTML Web 
content, and referenced by URLs. Hyperion Analyzer is commonly used to 
conduct sales and key performance, financial, and forecasting analyses.

Hyperion Analyzer Components
Hyperion Analyzer consists of the following components:

● Four client applications

● An analysis server

● A repository

● An API Toolkit

The repository centrally stores Hyperion Analyzer system data, user IDs, user 
preferences, and report definitions in relational database tables.
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The Hyperion Analyzer Analysis Server communicates report definitions and 
system information between the repository, Web clients, and Hyperion Analyzer 
Administration Tools.

The Hyperion Analyzer Administration Tools client provides a 100-percent Java 
graphical interface for managing users, users groups, and database connections 
using a supported Web browser. It also provides access to several administration 
utilities.

The Hyperion Analyzer Java Web Client is an easy-to-use graphical interface that 
enables online analysis of both Hyperion Essbase and relational data. You can 
design and format custom analysis applications without “coding.” 

The Hyperion Analyzer Windows Client is the same easy-to-use Java Web Client 
interface and functionality delivered as a standalone Java application for supported 
Microsoft Windows operating systems.

The Hyperion Analyzer HTML Web Client is a 100-percent HTML thin client 
used by way of a supported Web browser. It is engineered for information 
consumers who do not require advanced design and content-creation capabilities.

The Hyperion Analyzer API Toolkit enables developers to incorporate the 
Hyperion Analyzer Java Web Client look and feel and functionality into their own 
custom Web applications.

Hyperion Analyzer Architecture

The following illustration represents the architecture of Hyperion Analyzer and 
illustrates how the different components work together.
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Figure 1: Hyperion Analyzer Architecture Diagram
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User Types
Hyperion Analyzer users fit into five categories:

The following tables list recommended first steps for using Hyperion Analyzer 
based on which kind of user you are.

Evaluators

Table 1: Hyperion Analyzer Users

User Description

System administrator Installs, configures, and maintains Hyperion 
Analyzer and its supporting platforms.

Power user/

standard user

Designs reports and establishes content for analysis 
and review; conducts and distributes analysis to 
information consumers.

Information consumer Reviews analysis.

Developer Incorporates Hyperion Analyzer look, feel, and 
functionality in custom Web applications.

Evaluators Appraises the use and benefit of Hyperion Analyzer 
for the enterprise.

Table 2: First Steps for Evaluators

Action Resource

1. Download free evaluation 
software.

The Hyperion Web site: 
www.hyperion.com

2. Familiarize yourself with 
Hyperion Analyzer concepts and 
procedures for both the Java Web 
Client and the HTML Web Client.

Chapters 1 - 5 of this guide

3. Evaluate a working Hyperion 
Analyzer system, including 
touring the sample report group 
and creating your first reports.

The procedures in chapters 6 - 8 of this 
guide
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Evaluation installation enables you to install and use all Hyperion Analyzer 
components for a thirty-day evaluation period. At the end of this period, you can 
either run a registration application or reinstall Hyperion Analyzer using an unlock 
code.

System Administrators

4. Appraise the full potential and 
benefits of Hyperion Analyzer.

Chapters 9 and 10 of this guide

5. Decide whether a more robust 
evaluation, using existing data 
sources, is required.

If so, contact a system administrator, 
and follow the objectives for Hyperion 
Analyzer Administrators.

Table 3: First Steps for Hyperion Analyzer Administrators

Action Resource

1. Download software. The Hyperion Web site: 
www.hyperion.com

2. Identify late-breaking issues 
specific to this release of 
Hyperion Analyzer.

The Hyperion Analyzer Readme

3. Establish Hyperion Analyzer 
system requirements and weigh 
installation options.

The Hyperion Analyzer Installation Guide

4. Install and configure Hyperion 
Analyzer.

Procedures in the Hyperion Analyzer 
Installation Guide

5. Configure and deploy Hyperion 
Analyzer Samples.

“Installing Hyperion Analyzer Samples” in 
the Hyperion Analyzer Installation Guide

6. Test and verify the environment. Hyperion Analyzer Administration Tools 
Online Help and the Hyperion Analyzer 
Administration Tools Console

Table 2: First Steps for Evaluators(Continued)

Action Resource
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Power Users

7. Familiarize yourself with 
Hyperion Analyzer concepts and 
procedures.

The remainder of this book

8. Establish an administration and 
maintenance strategy.

The Hyperion Analyzer Administrator's 
Guide

9. Deploy Hyperion Analyzer to 
users.

Table 4: First Steps for Power Users

Action Resource

1. Familiarize yourself with 
Hyperion Analyzer concepts and 
procedures for both the Java Web 
Client and the HTML Web Client.

Chapters 1 - 5 of this guide

2. Evaluate a working Hyperion 
Analyzer system, including 
touring the sample report group 
and creating your first reports.

The procedures in chapters 6 - 8 of this 
guide

3. Appraise the full potential and 
benefits of Hyperion Analyzer.

Chapter 9 and 10 of this book.

4. Locate additional information on 
Hyperion Analyzer Java Web 
Client.

The Hyperion Analyzer Information 
Map and Hyperion Analyzer Java Web 
Client Online Help

Table 3: First Steps for Hyperion Analyzer Administrators(Continued)

Action Resource
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Information Consumers

Developers

Table 5: First Steps for Information Consumers

Action Resource

1. Familiarize yourself with 
Hyperion Analyzer concepts and 
procedures for both the Java Web 
Client and the HTML Web Client.

Chapters 1 - 5 of this guide

2. Evaluate a working Hyperion 
Analyzer system, including 
touring the sample report group 
and creating your first reports.

The procedures in chapters 6 - 8 of this 
guide

3. Locate additional information on 
Hyperion Analyzer Java Web 
Client.

The Hyperion Analyzer Information 
Map and Hyperion Analyzer Java Web 
Client Online Help

Table 6: First Steps for Developers

Action Resource

1. Familiarize yourself with 
Hyperion Analyzer concepts and 
procedures for both the Java Web 
Client and the HTML Web Client.

Chapters 1 - 5 of this guide

2. Evaluate a working Hyperion 
Analyzer system, including 
touring the sample report group 
and creating your first reports.

The procedures in chapters 6 - 8 of this 
guide

3. Familiarize yourself with the 
wide range of analysis tools 
available to advanced Hyperion 
Analyzer users.

Chapter 9 and 10 of this book.
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4. Familiarize yourself with the 
Hyperion Analyzer API Toolkit.

The Hyperion Analyzer API Toolkit 
Developer's Guide.

5. Review examples of Hyperion 
Analyzer Web content as 
inspiration for your own Web 
pages.

The Hyperion Analyzer API Toolkit 
samples.

Table 6: First Steps for Developers(Continued)

Action Resource
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2
Overview of Multidimensional 
Analysis

Online Analytical Processing
Online Analytical Processing (OLAP) technology organizes key performance 
indicator data into models enabling speed-of-thought analysis.

Dimensions and Members
Business measurements, or values, are organized into arrays for consolidation and 
retrieval. These arrays, dimensions, are composed of values called members.

OLAP databases enable you to analyze multiple dimensions in relation to one 
another. Each data value represents the intersection of all the dimensions in a 
specific database.

Conventional spreadsheets relate cell values to the dimension headers of the 
corresponding rows and columns. There are even conventions for displaying a 
third dimension, the z-axis, in a two-dimensional chart.

OLAP technology however can represent multiple dimensional intersections as a 
cell value in two-dimensional media.

Multidimensional Cubes
A cube is an array organizing multiple dimensions. OLAP database queries 
request dimension member data from a cube.

Dimensional Hierarchies
There is a specific order, or hierarchy, to dimension members. It is specified by a 
database outline.
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Dimensions of numeric values follow a hierarchy of numerical order, but consider 
other hierarchies:

● Centuries, Decades, Years, Quarters, Months, Weeks, Days, Hours, Minutes, 
and Seconds are elements of the time hierarchy.

● Continents, Countries, Regions, States, Cities, Neighborhoods, Locations, and 
Departments are elements of the Market hierarchy.

Multiple members can belong to a single dimensional hierarchy;

● For example,Years, Quarters, and Months are members of the Time 
dimension.

A dimension can relate to different places in the hierarchy of another dimension;

● For example, a Cost dimension can be evaluated against years, quarters, 
weeks, or days.

Dimensions are organized into cubes using these hierarchical relationships.

Familial Relationships
Elements of greater detail are referred to as descendants of more general 
elements. Elements of more generality are conversely referred to as ancestors of 
more detailed elements. For example, Months, Weeks, and Days are all 
descendants of Time, Weeks are ancestors to Days.

To simplify hierarchical relationships, the terms parent and child are used. A 
parent is the direct ancestor of an element in a hierarchy. A child is the direct 
descendant of an element in a hierarchy.
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The following figure shows a typical time hierarchy.

Figure 2: A Time Dimension Hierarchy

Generations and Levels
Dimension members on the same layer of the dimensional hierarchy are referred 
to collectively as generations or levels.

Generations are hierarchical layers counted down from the highest ancestor 
(generation 0).

Levels are hierarchical layers counted up from the lowest descendant (level 0).
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Hyperion Essbase enables you to label and reference generations and levels.

Figure 3: Generations and Levels Diagram

Nonaggregate Dimensions
Previously mentioned dimension examples were aggregates of their members. For 
example, 24 hours make a day, 7 days compose a week, 52 weeks form a year, and 
so on. In these cases, the Time dimension literally represents the sum of its 
components.

However, some dimensional hierarchies are not the sum of their components. For 
example, The Measures dimension is commonly composed of business measures 
such as Sales, Profit, and Cost of Goods Sold. Relating these dimensions to other 
dimensions in the cube provides meaningful data. For example, the Scenario 
dimension is typically composed of measures such as Actual, Budget, Prior Year, 
and so on. These members cannot be combined to form a meaningful aggregate. 
The Scenario dimension is, therefore, only a descriptive label for the measures it 
contains.

When the dimension label cannot represent the sum of its contents, a protocol 
exists to use one member set in place of the dimension label. Hyperion Essbase 
uses the first child in the dimension outline as the implied share instead of 
nonaggregate dimension labels.



Overview of Multidimensional Analysis

2

■ 31Hyperion Analyzer Getting Started

Attributes
In addition to dimension member names, locations, and relationships, Hyperion 
Essbase can store characteristics about specific members. These are called 
attributes. For example, the product dimension may indicate that in Women's 
Apparel, Shirts and Blouses, there is a cotton T-shirt product; attributes can 
indicate that the cotton T-shirt is red, cyan, lime, or pink.

For example, the Market dimension may indicate there is a franchise store in 
Biloxi, Mississippi; attributes can indicate that the store size is 2500 square feet.

Hyperion Essbase does not store attribute dimensions as part of the OLAP cube but 
instead dynamically calculates them upon request.

It is important to know that attributes are displayed in dimension hierarchies, in the 
same manner as dimension members, despite being stored differently.

Sparse and Dense Dimensions
Most multidimensional databases lack member values in every single dimension 
member of every single intersection. For example, all products may not be sold in 
all areas of a country.

To maximize database performance, dimensions are labeled either sparse or 
dense. Sparse dimensions have a low percentage of member values for all possible 
cube intersections. Dense dimensions have a high percentage of member values for 
all possible cube intersections. Labeling dimensions as sparse and dense enables 
Hyperion Essbase to expedite retrieval while minimizing memory and disk 
requirements.

Organizing Reports

Reports
Hyperion Analyzer abstracts multidimensional and relational information into a 
two-dimensional display called a report. A report is both the content and the 
format of the display.

After they have been saved to the repository, reports become multipurpose files 
that you can display in numerous formats.
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Report Groups
Reports are organized into report groups. Report groups commonly contain 
reports relating to a single subject or common analytical purpose.

Report groups serve the following purposes:

● Coordinate information

● Enable specific distributions

● Enable frequently updated reports to be located easily

Properties
Reports and report groups have properties governing their display and use.
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Hyperion Analyzer Java Web 
Client Interface

The Hyperion Analyzer Java Web Client is an easy-to-use graphical interface that 
enables online analysis of both Hyperion Essbase and relational data. You can 
design and format custom analysis applications without “coding.” This chapter 
gives a brief overview of the Hyperion Analyzer Java Web Client user interface. 

Starting the Hyperion Analyzer Java Web Client
Before you start, a system administrator must provide a uniform resource locator 
(URL) for the Hyperion Analyzer Java Web Client launch page. 

➤ To start the Hyperion Analyzer Java Web Client:

1. Start a supported Web browser (such as Microsoft Internet Explorer 5.5 or 6.0 
or Netscape 6.2 or 7.0).

2. Select File > Open.

3. Enter the URL of the Hyperion Analyzer launch page, and press Enter.

4. Click the link launching the Hyperion Analyzer Java Web Client.

The Hyperion Analyzer application window is displayed, then the Login 
dialog box is displayed.

5. Enter a valid user ID and password in the Login dialog box.

6. Optional: If prompted with a Domain drop-down list box, select an 
authentication method.

Note: Your administrator establishes methods for authenticating your user ID and 
password during installation and configuration. You always have the option of using 
Standard Security, but if you use Essbase Authentication or External 
Authentication, you do not have to log on again to other integrated applications and 
data sources.
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7. Click OK.

The report or desktop specified by the Startup Options user preferences is 
displayed.

User Interface Modes
Hyperion Analyzer’s methods and metaphors make sophisticated 
multidimensional and relational analysis as easy as surfing the Internet.

Each of Hyperion Analyzer’s four user interface modes has a distinct interface and 
controls:

● Hyperion Analyzer Desktop - Centrally collects and presents report group 
icons.

● Normal Mode - Provides the fundamental analysis, presentation, and reporting 
interface for Hyperion Analyzer.

● Edit Data Mode - Enables you to edit cell values and write the edits back to 
Hyperion Essbase.

● Design Report Mode - Provides an interface for creating custom reports.
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Hyperion Analyzer Desktop
The Hyperion Analyzer Desktop centrally collects and presents report group icons. 
Report group icons are similar to application shortcuts on the Windows desktop.

Figure 4: Hyperion Analyzer Desktop

The Hyperion Analyzer Desktop displays only the report group icons to which you 
have access. You can customize the Hyperion Analyzer Desktop by hiding 
specific report group icons.

You can open all the reports in a report group by clicking the report group’s icon.
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Normal Mode
Normal mode provides the fundamental analysis, presentation and reporting 
interface for Hyperion Analyzer. Most of your work is done in Normal mode.

Figure 5: Hyperion Analyzer Normal Mode Interface

The Normal mode user interface is a composite of many components.

Application Window Title Bar
The application window contains all interface components. It features a title bar 
with Minimize, Restore, and Close buttons.

Figure 6: Hyperion Analyzer Application Window Title Bar
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The application window title bar displays the current application name and 
features a conventional right-click menu.

Figure 7: Application Title Bar Right-click Menu

Menu Bar
The menu bar is directly below the Application Window Title bar. The Menu bar 
organizes and provides access to principal Hyperion Analyzer tasks. You can hide 
the Menu bar to expand display panel space.

Figure 8: Hyperion Analyzer Menu Bar

Toolbar
The toolbar is located directly below the menu bar and above the Details bar. The 
toolbar provides single-click access to principal Hyperion Analyzer tasks.

You can also hide the toolbar to expand display space.

Figure 9: Hyperion Analyzer Toolbar

Details Bar
The Details bar, above the Main Display panel, displays and hides interface 
components. The buttons, titles, and graphics displayed on the Details bar change, 
based on the specific report and user preferences.
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Five default buttons are always displayed on the Details bar.

Figure 10: Hyperion Analyzer Details Bar

When the toolbar is hidden, some toolbar buttons are displayed dynamically on the 
Details bar. For this reason, you cannot hide the Details bar.

Report Tabs Bar
The Report Tabs bar is at the bottom of the application window, above the Status 
bar and below the Main Display panel. Report tabs do not display all possible 
reports, only opened reports. The tab control for the current report is highlighted 
in the tab series.

Figure 11: Hyperion Analyzer Report Tabs Bar

There is a tab for every opened report, but the tab series may extend beyond the 
display area. For this reason, a tab series control is included at the far left of the 
Report Tabs bar.

Status Bar
The status bar, at the very bottom of the application window, displays the current 
report description.

Figure 12: Hyperion Analyzer Status Bar
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Edit Data Mode
Edit Data mode enables you to edit cell values and write the edits back to Hyperion 
Essbase. Edit Data mode looks similar to Normal mode, but an Edit Data Bar is 
displayed at the bottom of the Main Display panel when you are in Edit Data mode.

Figure 13: Hyperion Analyzer Edit Data Mode

Figure 14: Edit Data Bar
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Design Report Mode
Design Report mode is an interface for creating custom reports. For more 
information on Design Report mode, see Chapter 9, “Creating a Dynamic Custom 
Report.”

Figure 15: Hyperion Analyzer Design Report Mode
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Main Display Panel Components
The Main Display panel is the largest area of the interface, located below the 
Details bar and above the Reports Tabs bar. The Main Display panel is a composite 
of four dynamic panels.

Figure 16: Exploded Main Display Panel

Information Panel
The Information panel is composed of segments summarizing the source and 
nature of the Main Display panel. Each segment features different controls and 
context-sensitive right-click menus.
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You can perform the following tasks using the Information panel:

● Display or hide the Information panel by clicking the Details bar Show/Hide 
Information Panel button.

Figure 17: Show/Hide Information Panel button

● Expand or collapse Information panel segments by double-clicking segment 
icons.

Figure 18: Collapsed Information Panel Segments

● Expand or collapse Information panel content by clicking plus and minus 
nodes.

● Modify the main display panel by dragging dimensions and dropping them 
between Information panel axes segments.

● Make new Dimension Browser selections by right-clicking dimension names.

● Expand or collapse the Information panel segments by right-clicking the 
Information panel and selecting Expand All or Collapse All.
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Page Control Panel
The Page Control panel enables you to jump and scroll between Page dimension 
members.

Figure 19: Page Control Panel

The intersections in the Main Display panel are organized with respect to the 
dimensions in the Page axis, and page control panel selections change the main 
display.

Filter Panel
The Filter panel indicates the dimensions assigned to the Filter axis. All Main 
Display panel intersections are relevant to Filter Dimension members.

Figure 20: Filter Panel

You can display or hide the Filter panel by clicking the Details bar Show/Hide 

Filter Panel button. 
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Main Display Panel Right-Click Menu
The Main Display panel right-click menu is context-sensitive, so menu options 
change based on the current selection.

Figure 21: Main Display Panel Right-Click Menu

The most advanced Hyperion Analyzer features are usually accessed through the 
Main Display Panel right-click menu. 

Displaying and Hiding User Interface 
Components

Users can customize the Hyperion Analyzer interface to suit their needs and 
objectives. Analysts may want to display all interface components to reveal 
detailed information. Presenters may hide interface components in order to fully 
expand the Main Display panel.

The same report can be displayed with a combination of user interface 
components.
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Hiding Interface Components

➤ To hide the toolbar, click the Show/Hide Toolbar button. 

➤ To hide the Information panel, click the Show/Hide Information Panel  
button.

➤ To hide the Filter panel, click the Show/Hide Filter Panel button. 

➤ To hide the menu bar, right-click the Details bar and select Show Main Menu.

Because the Details bar cannot be hidden, you can always redisplay hidden 
interface components.
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Using the Java Web Client

If you have not yet started the Hyperion Analyzer Java Web Client, see “Starting 
the Hyperion Analyzer Java Web Client” on page 33.

Opening Reports
There are several methods for opening report groups and specific reports.

➤ To open a report using Report Manager, take one of the following actions:

● Select File > Open.

● Click the Toolbar Open button.

Figure 22: Toolbar Open Button

You can also use the Hyperion Analyzer Desktop to open a report group. The 
Hyperion Analyzer Desktop displays only the report group icons to which you 
have access.

➤ To open a report group from the Hyperion Analyzer Desktop:

1. Select Analyzer Desktop from the Home toolbar button drop-down menu.

2. Click the icon for the report group you want to open.

You can also open the Sample Report Group from the Hyperion Analyzer Desktop.
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➤ To open the Sample Report Group, click the Sample Report Group icon.

Navigating Between Reports
Opening a report group also opens all the reports in that group. The reports are 
represented as tabs on the Report Tabs bar.

Open reports form a series through which you can browse and scroll. If there are 
more reports than the Report Tabs bar can accommodate, a Report Tab Series 
control is displayed.

Figure 23: Hyperion Analyzer Reports Tab Bar

The report displayed in the Main Display panel is the current report. The name of 
the current report is highlighted on the Report Tabs bar.

➤ To navigate between open reports, use one of the following methods:

● Click the toolbar Back or Forward buttons. 

● Select Go > Back or Go > Forward.

● Select a Report tab to make that report the current report.

● Click a report link leading to another report.

Display Types
You can present the same information in these three formats:

● Spreadsheet

● Chart

● Pinboard

Each of these display types has prerequisites.
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Spreadsheets
Spreadsheets organize information into column, row, page, and filter axes.

Figure 24: Hyperion Analyzer Spreadsheet Display Type

Spreadsheet cells show the value assigned to an intersection of all dimensions, not 
just those in rows and columns.

All cells in the cube are filtered according to dimensions assigned to the Filter axis. 
Dimensions assigned to rows and columns are then organized in terms of the 
dimensions assigned to the Page axis.

The result is a multidimensional spreadsheet.
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Charts
Hyperion Analyzer enables multidimensional spreadsheets to be displayed as 
charts.

Figure 25: Hyperion Analyzer Chart Display Type

You can choose from a variety of chart types:

● Bar

● Line

● Spline

● Pie

● Area

● Curve Area

● Horizontal Bar

● Marks

● Pareto

● Box

● Quadrant

● Bubble
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Pinboards
Pinboards are custom graphic representations of spreadsheets. Pinboard 
dimensions are represented by a graphic, pins located on the graphic, and the color 
or state of the pins.

Figure 26: Hyperion Analyzer Pinboard Display Type

Any graphic can be used as a pinboard, enabling numerous creative opportunities.

You must create a multidimensional spreadsheet with a Traffic Lighting definition 
before you can create a pinboard, because pins dynamically change image or color 
based on Traffic Lighting cues. For more information about Traffic Lighting, see 
“Enhanced Traffic Lighting” on page 150. 

Changing Display Types
You can change the display type to better present information, facilitate 
comparisons, or illustrate information graphically.

Figure 27: Toolbar Display Button

Report designers can also lock the Display Type report property to prevent 
subsequent users from changing the report.
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Custom Reports
Hyperion Analyzer custom reports can contain multiple display types, a variety of 
controls, graphics, and custom features and functionality. The report creation 
possibilities are infinite.

Figure 28: Hyperion Analyzer Custom Report

Custom reports are designed in Design Report mode. For more information, see 
Chapter 9, “Creating a Dynamic Custom Report.”

Navigating Reports
You can rearrange, expand, and concentrate OLAP intersections for focused 
analysis. Because these methods represent travel through an OLAP cube, they are 
called navigation methods. Hyperion Analyzer supports the following navigation 
methods:

● Paging

● Swapping and Moving

● Drilling

● Drill Linking
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Paging
The Page Control panel enables you to jump and scroll between Page dimension 
members.

Figure 29: Page Control Panel

The intersections in the Main Display panel are organized with respect to the 
dimensions in the Page axis, and Page Control panel selections change the Main 
Display.

You can perform the following tasks using the Page Control panel:

● To select a page dimension member combination, click the drop-down list 
box.

● To scroll through Page series combinations, click the scroll buttons.

● To separate dimension member combinations into multiple drop-down list 
boxes, click the Page icon.

The Page Control panel can display multiple page drop-down list boxes when 
working with Page dimension combinations. Multiple page drop-down list boxes 
display all possible page combinations whether or not data exists. Single page 
drop-down list boxes omit page combinations that do not contain data.

Hyperion recommends using a single page drop-down list box when working with 
sparsely populated dimensions, so only populated pages are displayed.

Swapping and Moving
You can rearrange column and row dimensions by swapping and moving.

● Swapping switches two dimensions in the Main Display panel, replacing one 
with the other.

● Moving relocates the selected dimension in the Main Display panel.

Swapping and moving procedures are nearly identical in their use of 
drag-and-drop methods. They differ only in where the dimension is dropped.
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➤ To swap, drop a dimension on another dimension.

➤ To move, drop a dimension between other dimensions after the bold rule is 
displayed.

Display Types require you to have at least one dimension on both the column and 
row axis at all times.

Drilling
Drilling increases or decreases the level of report detail by changing the display of 
dimension members. Because you can customize drilling by way of User 
Preferences and report properties, the term drilling can refer to almost any 
hierarchical navigation that is prompted by double-clicking a dimension label.

Hyperion Analyzer is delivered with default drilling behavior:

● Drill-down includes children of a member in the display.

● Drill-up includes a parent of a member in the display.

● Drill-to-top includes the highest ancestor in the display.

Drill-up and drill-to-top options are fixed, but you can override the drill-down 
behavior by changing the drilling report properties.

You can elect to add the drilling return set to the currently displayed dimension 
members, or to replace the currently displayed dimension members with the 
drilling return set.

● The Append Member Selections option on the drilling user preferences tab 
adds the drilling return set to currently displayed dimension members.

● The Replace Member Selections option on the drilling user preferences tab 
replaces the currently displayed dimension members with the drilling return 
set.
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➤ To view a complete list of report-based drilling options, right-click the Main 
Display panel and select Drill > Drill Options.

Figure 30: Java Web Client Drilling Options

Selecting a drilling option sets hierarchical navigation for that specific report 
during the session. If you save the report, the drilling option is recorded as a report 
property, and the hierarchical navigation persists when other users view the report.

The Expand on Drill drilling option duplicates the Append Member Selections and 
Replace Member Selections options previously described.

Drill Linking
Drill linking navigates to other reports where you double-click cells with 
preplaced links. You must differentiate between double-clicking headers and 
drilling down the dimension hierarchy, and double-clicking a cell with a drill link 
to navigate to another report.

Formatting Reports
You access formatting options for Hyperion Analyzer reports through the Main 
Display Panel right-click menu, and the User Preferences dialog box.

Each display type features its own formatting options:

● Spreadsheet options enable you to format spreadsheet background, all 
headers, all data cells, and other spreadsheet specific options.
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● Chart Properties enable you to set several different chart options for all types 
of charts, including the number of axes, the shapes of chart objects, the 
number of chart series, the colors of pie wedges, the fonts used for titles, the 
formats of legends, and many others.

● Pinboard properties are set exclusively through the Pinboard Designer dialog 
box. You can set background images, pin color, and pin image and associate 
pins with specific dimension members. You can also create pins for calculated 
members and set behavior for pins with null values.

Column sizing enables you to format dimension headers on spreadsheet column 
axes.

Data display options enable you to specify report behavior, such as the label mode, 
the to order dimension headers, whether Linked Reporting Object indicators are 
displayed, and whether missing rows are displayed. These options are discussed at 
length in later chapters.

Formatting options enable you to format specific dimension headers and specific 
ranges of data cells. You can restrict formatting based on dimension member 
selection, or data cell values. Formatting options include currency formatting and 
Numeric formatting for positive and negative values.

Scope of Formatting Options
The scope of formatting varies depending on the source of the formatting 
definition. Because formatting definitions can be saved as database connection 
properties, user ID properties, or a report-based properties, they can be applied to 
any report using a particular database connection, all reports reviewed by a user, 
or to just a specific report.
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The following table delineates the scope, nature and order of precedence by which 
different formatting options are applied: 

Saving Reports
You can use any of these methods for saving a report:

● Click the Toolbar Save button.

● Select File > Save.

● Select Save from the Report tabs right-click menu

Saving stores the query, report properties, and formatting in the Hyperion 
Analyzer repository.

Table i: Scope of Formatting Options and Order of Precedence

Formatting Definition Formatting Options Scope

Measures formatting Leading and trailing, 
currency formatting, 
numeric formatting

Measures formatting is saved as 
a database connection property 
and applied to all reports that use 
the database connection.

Default formatting 
user preferences

Spreadsheet options, 
chart properties, data 
display

User preferences are saved as 
properties of the user ID and 
applied as default settings to all 
reports reviewed by a user.

Formatting Spreadsheet options, 
chart properties, data 
display

Formatting is saved as a property 
of the specific report and must be 
redefined for each report.

Formatting analysis 
tool

Data formatting 
criteria (used to 
identify subjects for 
analysis)

Data formatting and conditional 
formatting are saved with the 
report but are applied after 
almost all other formatting 
options.

Cell formatting Format for a specific 
range of cells

Cell formatting is applied last to 
a specific range of cells and 
saved with the report.
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You can save reports only into report groups shared with you.

Distributing Reports
The routing and distribution of reports and permission to open them are controlled 
by report group properties. 

Shared to User Group Report Group Property
The Shared to User Group report group property controls the distribution of reports 
and report groups in Hyperion Analyzer. Using this report group property, you can 
assign reports and report groups to user groups. Only users in the specified user 
group can open the report group. In addition, only user group members can alter 
report and report group properties.

Locking Reports
While report group properties determine access to and distribution of reports, you 
can lock reports to further restrict, or direct, exploration in reports, right-click 
menu options, and navigation methods.

External Distribution of Reports and Report Groups
Hyperion Analyzer reports and report groups can be distributed externally by these 
means:

● Two printing contexts: Print Screen prints the current page of the current 
report, and Print Select Object prints the specified OLAP pages of the current 
data object

● Publishing reports and report groups to the Web, by specifying a JSP templates 
and an output file

● Exporting reports to Microsoft Excel spreadsheets

● Exporting report selections to the operating system clipboard or to a file, in a 
tab-delimited format, so Hyperion Analyzer data can be pasted in other 
applications

● Exporting individual reports and report groups as discrete files (with the .ard 
and .arg file name extensions respectively) that other Hyperion Analyzer users 
can review
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● E-mailing to other users the hyperlink to the URL of the current report, and 
specifying whether to present the report in the HTML Web Client or the Java 
Web Client.
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Hyperion Analyzer HTML Web 
Client Interface

The Hyperion Analyzer HTML Web Client is a 100-percent HTML thin client 
used by way of a supported Web browser. It is engineered for information 
consumers who do not require advanced design and content-creation capabilities.

Starting the Hyperion Analyzer HTML Web Client
Before you start, a system administrator must provide a uniform resource locator 
(URL) for the Hyperion Analyzer HTML Web Client launch page.

➤ To start the Hyperion Analyzer HTML Web Client:

1. Start a supported Web browser (such as Microsoft Internet Explorer 5.5 or 6.0 
or Netscape 6.2 or 7.0).

2. Select File > Open.

3. Enter the URL of the Hyperion Analyzer launch page, and press Enter.

4. Click the link launching the Hyperion Analyzer HTML Web Client.

The Hyperion Analyzer application window is displayed, then Login dialog 
box is displayed.

5. Enter a valid user ID and password in the Login dialog box.

6. Optional: If prompted with a Domain drop-down list box, select an 
authentication method.

Note: Your administrator establishes methods for authenticating your user ID and 
password during installation and configuration. You always have the option of using 
Standard Security, but if you use for Essbase Authentication or External 
Authentication, you do not have to log on again to other integrated applications and 
data sources.
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7. Click OK.

The report or desktop specified by the Startup Options user preferences is 
displayed.

HTML Web Client User Interface
The HTML Web Client interface differs significantly from the Java Web Client 
interface because the HTML Web Client uses standard HTML technologies to 
present much of the same functionality provided by the Java Web Client applet.

For the same reason the HTML Web Client is completely customizable. Web 
developers can edit the JSP templates on the application server or write their own 
interfaces. For more information on editing the Hyperion Analyzer JSP templates, 
see the Hyperion Analyzer Administrator’s Guide.

In this section we discuss the default interfaces delivered with Hyperion Analyzer.

User Interface Modes
The Hyperion Analyzer HTML Web Client presents three of the four modes used 
by the Java Web Client:

● Hyperion Analyzer Desktop - Centrally collects and presents report group 
icons.

● Normal Mode - Provides the fundamental analysis, presentation, and reporting 
interface for Hyperion Analyzer.

● Edit Data Mode - Enables you to edit cell values and write the edits back to 
Hyperion Essbase.

Each mode has a distinct user interface and its own controls.

The absence of Design Report mode is one of the major differences between the 
HTML Web Client and Java Web Client. HTML Web Client users can display and 
use custom reports created by the Java Web Client, but they just cannot create 
custom reports in the HTML Web Client.
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Hyperion Analyzer Desktop
The Hyperion Analyzer Desktop centrally collects and presents report group icons. 
Report group icons are similar to application shortcuts on the Windows desktop.

Figure 31: Hyperion Analyzer HTML Web Client Desktop

➤ To access the Desktop, click the Home hyperlink from the HTML Web Client 
toolbar.

➤ To open all the reports in a report group, click the report group’s icon hyperlink.
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Normal Mode
Normal mode provides the fundamental analysis, presentation and reporting 
interface for Hyperion Analyzer. Most of your work is done in Normal mode.

Figure 32: Hyperion Analyzer HTML Web Client Normal Mode Interface

The following components comprise the Normal mode user interface.

Toolbar
The Toolbar is located at the top of the HTML Web Client Interface. The Toolbar 
provides single-click access to principal Hyperion Analyzer tasks.

Figure 33: Hyperion Analyzer HTML Web Client Toolbar
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The toolbar is organized into three rows of hyperlinks. The top row of hyperlinks 
lists the application name, the report name, and a series of report navigation 
controls.

Table 7: First Row of Hyperlinks from the HTML Web Client Toolbar

The second row of hyperlinks (gradiated background) controls the Hyperion 
Analyzer application.

Table 8: Second Row of Hyperlinks from the HTML Web Client Toolbar

Hyperlinks Description

Hyperion 
Analyzer

Clicking the Hyperion Analyzer product name displays the About 
dialog box, containing license and version information

Report Name The top line of the Toolbar displays the name of the current report, 
when a report is open.

Home Display the Hyperion Analyzer Desktop.

New Displays the New Report dialog box (Select Layout).

 Back Navigates to the previous report in the report group series.

Forward Navigates to the next report in the report group series.

Close Shows/Hides the Report Manager panel.

Logoff Ends the Hyperion Analyzer session.

Help Displays the Information Map.

Hyperlinks Description

Edit Data Initiates Edit Data mode.

Save Saves the current report using its current name and location.

Save As Displays the Save Report dialog box to save a report to a different 
name or report group location.

Reload Displays the current report as it was last saved.

Analyze Displays the current report in the Hyperion Analyzer Java Web 
Client.
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The last row of hyperlinks (dark teal) controls the display of the current report.

Table 9: Third Row of Hyperlinks from the HTML Web CLient Toolbar

Print Exports the current page of the current report to another window 
and displays the Web browser Print dialog box.

Drill/Browse: Clicking the corresponding drop-down list box enables you to 
select a drilling method for mouse-click events. Alternatively you 
can also display the Dimension Browser dialog box.

Hyperlinks Description

Information 
Panel

Shows/Hides the Information panel.

Filters Shows/Hides the Filter panel.

Pages Shows/Hides the Page Control panel.

Style Toggles between the JSP template that replicates the report style 
of the Java Web Client and the JSP template that uses the HTML 
Web Client report style.

Chart Type: Clicking the corresponding drop-down list box enables you to 
select a different (HTML Web Client-supported) display type or 
chart type.

Resize: Label for two resizing methods.

Auto Maximizes the report to the largest area possible.

Numeric Shows/Hides the Resize Report panel, used to manually specify a 
height and width for the current report.

Hyperlinks Description
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Edit Data Mode
Edit Data mode enables you to edit cell values and write the edits back to Hyperion 
Essbase. Edit Data mode looks similar to Normal mode, but there is no Edit Data 
Bar in the HTML Web Client. Spreadsheet cells transform into text boxes and are 
accompanied by Send Data and Exit buttons.

Figure 34: Hyperion Analyzer Edit Data Mode
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Main Display Panel Components
The Main Display panel is the largest area of the interface, located below the 
Toolbar. The Main Display panel is a composite of four dynamic panels.

Figure 35: Main Display Panel

Information Panel
The Information panel is composed of segments summarizing the source and 
nature of the Main Display panel. Each segment features different 
context-sensitive controls and hyperlinks.

The Information Panel features icons that move dimension member selections 
between axes.

Figure 36: HTML Web Client Information Panel Move Icons
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The example above shows icons for these commands: Move Up In Current Axis 
Order, Move Down in Current Axis Order, Move to Rows, Move to Columns, 
Move to Filters, and Move to Pages.

You can take the following actions using the Information panel:

● Display or hide the Information Panel by clicking the Information Panel 
hyperlink on the toolbar.

● Move dimension member selections to other axes, and modify the main 
display by clicking icons in axes segments.

● Display the Dimension Browser dialog box and define new dimension 
member selections, by clicking the dimension member hyperlink.

● Close the Information Panel by clicking the Hide button.

Page Control Panel
The Page Control panel enables you to jump and scroll between Page dimension 
members.

Figure 37: HTML Web Client Page Control Panel

The intersections in the Main Display panel are organized with respect to the 
dimensions in the Page axis, and Page Control panel selections change the Main 
Display.

You can perform the following tasks using the Page Control panel:

● To display or hide the Page Control panel, click the Pages hyperlink on the 
bottom row of the Toolbar.

● To select a page dimension member combination, click the drop-down list 
box.

● To scroll the combinations in the Page series, click the Back and Forward 
buttons.

● To separate dimension member combinations into multiple drop-down list 
boxes, click the Multipage button.
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The Page Control panel can display multiple page drop-down list boxes when 
working with Page dimension combinations. Multiple page drop-down list boxes 
display all possible page combinations whether or not data exists. Single page 
drop-down list boxes omit page combinations that do not contain data.

Hyperion recommends using a single page drop-down list box when working with 
sparsely populated dimensions, so only populated pages are displayed.

Filter Panel
The Filter panel indicates the dimensions assigned to the Filter axis. All Main 
Display panel intersections are relevant to Filter Dimension members.

Figure 38: HTML Web Client Filter Panel

You can display or hide the Filter panel by clicking the Details bar Show/Hide 
Filter Panel button.
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Report Manager Panel
The Report Manager provides a graphic interface for organizing and retrieving 
reports from the Hyperion Analyzer repository. Like the Hyperion Analyzer 
Desktop, it is used to locate report groups and open the reports inside.

Figure 39: Report Manager Panel

You can perform the following tasks using the Report Manager:

➤ To display or hide the Report Manager panel, click the Open/Close hyperlink on 
the top row of the toolbar.

➤ To display a list of reports in a group, click a report group hyperlink or a plus sign 
(+) node.

➤ To open the report, click a report hyperlink.

Controlling User Interface Components
You can customize the Hyperion Analyzer interface to suit your needs and 
objectives. Analysts may want to display all interface components to reveal 
detailed information. Presenters may hide interface components in order to fully 
expand the Main Display panel.
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The same report can display using a combination of user interface components, 
styles, and templates.

Hiding Interface Components

➤ To hide the Information panel, click the Information Panel hyperlink.

➤ To hide the Filter panel, click the Filters hyperlink.

➤ To hide the Page Control panel, click the Pages hyperlink.

➤ To hide the Report Manager panel, click the Close hyperlink on the top row of the 
Toolbar.

Resizing the Main Display Panel
There are two methods of sizing Hyperion Analyzer reports in the HTML Web 
Client:

● The Numeric hyperlink on the bottom row of the HTML Web Client toolbar 
displays the Resize Report panel.

Figure 40: HTML Web Client Resize Report Panel

The Resize Report panel enables you to enter height and width dimensions for the 
report. Clicking the Resize button resizes the report to the specified dimensions, 
and augments the report with a scroll bar (as needed).

● The Auto hyperlink on the bottom row of the HTML Web Client toolbar 
resizes current report to the largest area possible.
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Setting the Interface Style
The HTML Web Client is delivered with JSP templates that enable reports to be 
displayed in two styles.

The default style replicates the Java Web Client look and feel for HTML Web 
Client users.

Figure 41:  HTML Web Client: JWC Style

The formatting in the example above uses color, font, and style properties set using 
Java Web Client Spreadsheet Options.

You can select to display the same content using HTML Web Client report style 
by clicking the Style hyperlink on the bottom row of the toolbar.

Figure 42:  HTML Web Client: HTML Web Client Style

You can develop your own JSP pages and present a customized look and feel to 
your reports.
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If you have not yet started the Hyperion Analyzer HTML Web Client, see “Starting 
the Hyperion Analyzer HTML Web Client” on page 61.

Opening Reports
There are two methods for opening report groups and specific reports:

● The Report Manager panel enables you to organize and retrieve reports and 
report groups.

● The Hyperion Analyzer Desktop centrally locates report group icons. It 
displays only the report group icons to which you have access.

➤ To open a report, take one of the following actions:

● To display or hide the Report Manager panel, click the Open/Close 
hyperlink on the top row of the Toolbar.

Figure 43: Report Manager Panel

● Click the Home hyperlink from the HTML Web Client toolbar and click the 
corresponding report group icon hyperlink.
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➤ To open the Sample Report Group from the Desktop, click the Sample Report 
Group icon.

Navigating Between Reports
Open reports form a series through which you can browse and scroll.

The report displayed in the Main Display panel is referred to as the “current 
report.” The name of the current report is displayed on the Toolbar.

➤ To navigate between open reports, use one of the following methods:

● Click the Toolbar Back or Forward hyperlinks. 

● Click a report hyperlink leading to another report.

Display Types
You can present the same information in these three formats:

● Spreadsheet

● Chart

● Pinboard

Each of these display types has prerequisites.
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Spreadsheets
Spreadsheets organize multiple dimensions into column, row, page, and filter 
axes.

Figure 44: Spreadsheet Display Type in HTML Web Client

Spreadsheet cells show the value assigned to an intersection of all dimensions, not 
just those in rows and columns.

All cells in the cube are filtered according to dimensions assigned to the Filter axis. 
Dimensions assigned to rows and columns are then organized in terms of the 
dimensions assigned to the Page axis.

The result is a multidimensional spreadsheet.

Charts
Hyperion Analyzer enables spreadsheets to be displayed as charts.

Figure 45: Chart Display Type in HTML Web Client

You can choose from a variety of chart types:
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● Bar

● Line

● Spline

● Pie

● Area

● Curve Area

● Horizontal Bar

● Marks

● Pareto

● Box

● Quadrant

● Bubble

Pinboards
Pinboards are custom graphic representations of spreadsheets. Pinboard 
dimensions are represented by a graphic, pins located on the graphic, and the color 
or state of the pins.

Figure 46: Spreadsheet Display Type in HTML Web Client

Any graphic can be used as a pinboard, enabling numerous creative opportunities.
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You must create a multidimensional spreadsheet with a Traffic Lighting definition 
before you can create a pinboard, because pins dynamically change image or color 
based on Traffic Lighting cues. For more information about Traffic Lighting, see 
“Enhanced Traffic Lighting” on page 150. 

Changing Display Types
You can change the display type to better present information, facilitate 
comparisons, or illustrate information graphically.

➤ To change the display type of the current report, select a display type or chart type 
from the Chart Type drop-down list box.

Figure 47: HTML Web Client Chart Type drop-down List Box

You cannot select Pinboard as a display type in the HTML Web Client. While 
pinboards can be displayed by the HTML Web Client, they cannot be created using 
it.

Report designers can also lock the Display Type report property to prevent 
subsequent users from changing the report. So, it may not be an accident if you 
cannot change the display type on someone else’s report.

Navigating Reports
You can rearrange, expand, and concentrate OLAP intersections for focused 
analysis. Because these methods represent travel through an OLAP cube, they are 
called navigation methods. Hyperion Analyzer supports the following navigation 
methods:

● Paging
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● Moving

● Drilling

● Drill linking

Paging
The Page Control panel enables you to jump and scroll between Page dimension 
members.

For Example, if the Time dimension is placed on the Page axis and four calendar 
quarters are selected, then the same row and column dimensions can be compared 
over the course of four quarters.

Figure 48: HTML Web Client Page Control Panel

The intersections in the Main Display panel are organized with respect to the 
dimensions in the Page axis, and page control panel selections change the main 
display.

You can perform the following tasks using the Page Control panel:

● To display or hide the Page Control Panel, click the Pages hyperlink on the 
bottom row of the toolbar.

● To select a page dimension member combination, click the drop-down list 
box.

● To scroll the combinations in the Page series, click the Back and Forward 
buttons.

● To separate dimension member combinations into multiple drop-down list 
boxes, click the Multipage button.

The Page Control panel can display multiple page drop-down list boxes when 
working with page dimension combinations. Multiple page drop-down list boxes 
display all possible page combinations whether or not data exists. Single page 
drop-down list boxes omit page combinations that do not contain data.
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Hyperion recommends using a single page drop-down list box when working with 
sparsely populated dimensions, as only populated pages are displayed.

Moving
You can rearrange dimension member selections in the Main Display using Move 
icons in the Information Panel.

➤ To display or hide the Information Panel, click the Information Panel hyperlink 
on the Toolbar.

➤ To move dimension member selections within the current axis, or to another axis, 
click the Move icons in the axes segments.

Figure 49: HTML Web Client Information Panel Move Icons

The example above shows icons for these commands: Move Up In Current Axis 
Order, Move Down in Current Axis Order, Move to Rows, Move to Columns, 
Move to Filters, and Move to Pages.

Display Types require you to have at least one dimension on both the column and 
row axis at all times.

Drilling
Drilling increases or decreases the level of report detail by changing the display of 
dimension members. Because you can customize drilling, by way of User 
Preferences and report properties, the term drilling can refer to almost any 
hierarchical navigation.

The HTML Web Client is delivered with three default drilling behaviors:

● Drill-down includes children of a member in the display.

● Drill-up includes the parent of a member in the display.

● Drill-to-top includes the highest ancestor in the display.

Drill-up and Drill-to-top options are fixed, but you can override the drill-down 
behavior by changing the drilling report properties.
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User Preferences also specify the drilling return set to augment the currently 
displayed dimension members, or to replace the currently displayed dimension 
members.

● The Append Member Selections option on the drilling user preferences tab 
adds the drilling return set to currently displayed dimension members.

● The Replace Member Selections option on the drilling user preferences tab 
replaces the currently displayed dimension members with the drilling return 
set.

➤ To drill on the current report, select a drilling method from the Drill/Browse 
drop-down list.

Figure 50: Drill/Browse drop-down List Box

Drill Linking
Drill linking navigates to other reports using preplaced links. You must 
differentiate between drilling, which is hierarchical navigation, and drill linking, 
which is report navigation.

Saving Reports
Saving stores the query, report properties, and formatting in the Hyperion 
Analyzer repository.

Users can only save reports into report groups shared with them.

➤ To save the current report, click the Save toolbar hyperlink.
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➤ To save the current report under a new name or to a new report group, click the 
Save As toolbar hyperlink, and complete the Save As dialog box.

Figure 51: HTML Web Client Save As Dialog Box

Distributing Reports
The routing and distribution of reports and the permission to open them are 
controlled by report group properties. Although HTML Web Client users cannot 
set report group properties, they can understand who has access to the reports they 
create.

Shared to User Group Report Group Property
The Shared to User Group report group property controls the distribution of reports 
and report groups in the Hyperion Analyzer system.

Using this report group property, you can assign reports and report groups to user 
groups. Only users in the specified user group can open the report group. In 
addition, only user group members can alter report and report group properties.
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Creating a Report in the HTML Web Client

➤ To create a new report using the HTML Web Client:

1. Click the New hyperlink.

The New Report dialog box is displayed.

2. Select a display type option button.

You can select from Spreadsheet, Chart, a vertical chart and spreadsheet 
combination, or a horizontal chart and spreadsheet combination.

3. From the Connection drop-down list, select a database connection name.

4. Click the Create Report button.

A report of the specified display type is displayed in the Main Display.

The first dimension in the outline is positioned on the rows axis, and 
remaining dimensions are positioned on the columns axis. To rearrange 
dimensions, you must display the Information panel and use the move icons.

5. To display the Dimension Browser and define specific dimension member 
selections, click the dimension name hyperlinks.
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Editing Report Data
Hyperion Analyzer enables you to edit cell values and write these edits back to 
Hyperion Essbase. To do this, you must be in Edit Data mode.

Figure 52: Hyperion Analyzer Edit Data Mode

When a report is in Edit Data mode, spreadsheet cells transform into text boxes, 
and they are accompanied by Send Data and Exit buttons.

When you select Edit Data mode for chart display types, the chart is replaced by a 
spreadsheet with the same cell values.

➤ To edit report data values:

1. To initiate Edit Data mode, click the Edit Data toolbar hyperlink.

2. Click the text box for the cell you want to edit.

3. Enter a new data value.

4. To save this edit in the database, click the Send Data button.

The change is applied.

5. To end Edit Data mode, click the Exit button.
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Printing Reports

➤ To print the current report, click the Print toolbar hyperlink.

Passing the Current Report to the Java Web 
Client

Because the all Hyperion Analyzer advanced analysis functionality is not extended 
to HTML Web Client users, you may want to pass the current report to the Java 
Web Client. You can always save the report to the repository, and proceed with 
logging out and then back into to the Java Web Client. You can also proceed to the 
Java Web Client in a single step.

➤ To pass the current report to the Java Web Client, click the Analyze toolbar 
hyperlink.

Logging Off

➤ To end your HTML Web Client session, click the Logoff hyperlink.
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7
Touring the Sample Report 
Group

This chapter leads you through a step-by-step tour of the Hyperion Analyzer 
Sample Report Group. Along the way, key features of each report and advanced 
Hyperion Analyzer functionality are explained.

➤ To follow this tutorial, complete the procedures indicated by the arrow at left.

Starting the Hyperion Analyzer Java Web Client
If you have not yet started the Hyperion Analyzer Java Web Client, see “Starting 
the Hyperion Analyzer Java Web Client” on page 33.

Opening the Sample Report Group

➤ To locate the Hyperion Analyzer Desktop, select Home>Analyzer Desktop from 
the toolbar Home button drop-down menu.

Figure 53: Toolbar Home Button

➤ To open the Sample Report Group, click the Sample Report Group icon.

The first report in the Sample report group is displayed in the Main Display panel. 
Report tabs for the other reports in the report group are displayed in order along 
the bottom of the interface.
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Product Sales
The Product Sales report introduces the Sample Report Group and provides a 
starting point for OLAP and relational analysis.

The report charts product sales for each quarter organized with respect to their 
markets. With the Product Sales report, you can compare individual market 
performance, as well as review a summary for All Markets.

Figure 54: Product Sales Report

Key Features

➤ To page through the selected markets, click the Page control panel controls.

The Product Sales chart is a vertical bar chart. The chart display type provides you 
with 12 different chart options.
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➤ To display a complete list of display and chart types, click the Display toolbar 
button drop-down menu.

➤ To display the product name and its corresponding data value, click and hold the 
cursor over the individual bar chart objects.

The transparent chart background provides a strong graphical impact.

The sophistication of the chart engine reveals itself in chart details. Notice that the 
chart includes a custom legend and accommodates both currency symbols and 
decimals places.

➤ To proceed to the next report, click the Product Profitability report tab.

Product Profitability
The Product Profitability report is a multidimensional spreadsheet of product sales 
for each quarter, organized with respect to key business measures.

The nested dimensions on both the rows and columns axes specify the multiple 
dimensions involved in intersections. The most significant features in this report 
are the analysis tools.
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Figure 55: Product Profitability Report

Key Features
The Product Profitability report features a Traffic Lighting definition that 
compares product Actuals to Budgets and color codes intersections red, yellow, 
and green based on percent differences.

Analysts can determine instantly the ranges into which members fall, and the areas 
in where problems lie.

The Traffic Lighting analysis tool color-codes dimension member values. You can 
base color-coding on a comparison of two dimension members, or on fixed limits 
for a single dimension member. Traffic Lighting graphically associates member 
values, whether or not they are sorted or ranked.

The Calculations analysis tool inserts two calculated columns in the Product 
Profitability report.
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The % Total column calculates percent of Total profit by Product for each market.

The Rank column assigns a ranking based on the % Total calculated column. The 
Calculations analysis tool enables analysts to build increasingly complex 
interdependent calculations.

Calculated columns are maintained as the report is pivoted and changed, and 
dynamically update results and rankings when data values are reloaded.

➤ To proceed to the next report, click the Regional Analysis report tab.

Regional Analysis
The Regional Analysis report features a coordinated pinboard, chart, and 
spreadsheet that you can navigate using custom selection controls.

Figure 56: Regional Analysis Report
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Key Features
The Regional Analysis report features a pinboard display type. Pinboards are 
custom graphic representations of multiple dimensions. Pinboard dimensions are 
represented by a graphic, pin icons located on the graphic, and the color (or state) 
of the pins.

In the case of the Regional Analysis pinboard, the map background represents the 
Markets dimension. The children of Markets are displayed and located as pin icons 
for East, South, Central, and West. Traffic lighting definitions comparing Actual 
to Budget determine the state of the traffic light pins.

The Regional Analysis report is an excellent example of a Hyperion Analyzer 
custom report. With the advent of Hyperion Analyzer 6.0, you can create 
sophisticated custom report layouts in a programming-free environment, without 
leaving the Hyperion Analyzer Java Web Client.

A nonvisual data source object stores the database query and client-based 
formatting for a named database connection. As a result, all the objects on the 
report using that data source are coordinated.

This means that the custom selection controls in the Regional Analysis report 
prompt navigation in the coordinated pinboard, spreadsheet, and chart objects.

Hyperion Analyzer supports Hyperion Essbase attribute dimensions. Attributes 
are characteristics of conventional dimensions. Caffeination and Package Type are 
characteristics of Product dimension members. You can browse and select attribute 
dimensions the same way they select conventional dimensions using the 
Dimension Browser.

Drilling increases or decreases the level of report detail by including or excluding 
members of the dimension hierarchy in the report display. Drilling methods can be 
customized in the User Preferences dialog box, enabling a variety of hierarchical 
navigation.

➤ To drill down from All Markets to include Southern markets, double-click the 
South pin.

Notice that the chart and spreadsheet include the Southern markets.

➤ Click the Can option button under the Package Type selection control.

Once again, all report objects accommodate the selection.
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➤  To proceed to the next report, click the KPI Scorecard report tab.

KPI Scorecard
The Key Performance Indicator (KPI) Scorecard report demonstrates another use 
of pinboards. Product dimension members have been organized into pages that 
display key business measure pin icons.

Figure 57: KPI Scorecard Report

Key Features
The pin icons are color-coded using a traffic lighting definition that compares 
Actual to Budget.
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Instead of drilling down through the dimension hierarchy, these pins have been set 
to drill link to reports displaying detailed information about the nature of the 
Actual to Budget comparison.

➤ Double-click the Sales pin icon to drill link to the KPI Details report.

Figure 58: KPI Details Report

The KPI Details report is derived from a relational database. Hyperion Analyzer 
enables you to access and analyze relational data in the same way you analyze 
OLAP data.

The interface for defining relational database access has been improved, and 
employs a relational database wizard. Now, you can access relational data, 
regardless of where it is located, and merge relational and multidimensional data 
on the same report.
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➤ To show the initial reports tabs in the series, click the first button on the Reports 
Tab scroll bar.

➤ To proceed to the next report, click the Expense Analysis report tab.

Expense Analysis
The Expense Analysis report details expenditures for the year as organized by 
product.

Figure 59: Expense Analysis Report

Key Features
Despite employing a conventional spreadsheet display type, the Expense Analysis 
report is a custom report.
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The Expense Analysis report contains a dynamic text box used for annotating 
reports. Analysts can review these notes relating to specific expenditures and their 
long-term benefits.

➤ To display the Information panel, click the Details bar Show/Hide Information 
Panel button.

The Information panel is composed of segments summarizing the source and 
nature of the Main Display panel. Each segment features different controls and 
context-sensitive right-click menus. Dragging dimensions between Information 
panel axes segments modifies the Main Display panel. You can also right-click 
dimensions in the Information panel to make new Dimension Browser selections.

➤ Click the report tabs scroll button until the State Rankings report tab is displayed, 
then click the State Rankings report tab.

State Rankings
The State Rankings report ranks state markets for the last year and, using a traffic 
lighting definition, color-codes intersections based on whether they have moved up 
or down in rank over time.
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Figure 60: State Ranking Report

Key Features
Analysts can page through the different rankings for each member of the Measures 
dimension (Sales, Cost of Goods Sold, Margins, Total Expenses, and Profit).

Notice that the Information panel describes the traffic lighting criteria applied to 
the Q2, Q3, and Q4 columns separately. Analysts can then better understand the 
nature of the color-coding or decide if they would like to alter the traffic lighting 
definitions.

The Information panel also indicates that the Sorting analysis tool has been 
employed to arrange markets in ascending order based on Q1 rank.
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➤ To hide the Information panel, click the Details bar Show/Hide Information 
Panel button.

To focus your analysis, you can narrow the spreadsheet to those states 
demonstrating decreasing performance. Because traffic lighting definitions are 
already in place, you can accomplish this by filtering on traffic lighting color.

The Show/Hide Only analysis tool provides the ability to include or exclude 
dimension members from the main display panel using member name, traffic 
lighting color, or data value criteria. It is an excellent way to focus analysis on a 
discrete set of values.

➤ To create a Show/Hide Only definition:

1. Right-click the Q2 dimension member label, and select Analysis Tools > 
Show/Hide Only.

2. From the Select Method group, select the Show option button.

3. In the Where group, click the Any Colors option button.

4. In the Set Condition group, select Equal to from the drop-down list and then 
click the Color button.

5. From the Select Color dialog box, Select Red (the color of decreasing 
performance).

6. Press the Ctrl key and click the Q2 Rank, Q3 Rank, and Q4 Rank member 
names on the Members panel.

7. Click Apply and then click OK

The spreadsheet now displays only Market dimension members with at least one 
red traffic light intersection. This makes it much easier to identify and address the 
problems behind these declines.

➤ To proceed to the High/Low States report, click the toolbar Forward button.

High/Low States
The High/Low States report summarizes the best and worst performing states by 
quarter for specific and overall Products.
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Figure 61: High/Low States Report

Key Features
The entire report displays only calculated columns. All the dimension members 
and data value intersections have been hidden using the Show/Hide Only analysis 
tool.

The Top and Bottom states are determined using the Calculations analysis tool 
Max and Min calculations.
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➤ To display the Margin Chart report, click the toolbar Forward button.

Margin Chart
The Margin Chart report displays both sales figures and profit percentage by 
product.

Figure 62: Margin Chart Report

Key Features
A new chart engine enables the simultaneous display of multiple chart types. In the 
figure, both a bar and a 3-D line chart are employed at the same time.

Notice that the line chart is relative to a secondary y-axis, representing profit 
percentage rates, across from the y-axis representing sales values in dollars.
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Parallel axes enable information to be scaled independently but displayed 
alongside other dimensions. Where a y-axis of percentages plotted on the same 
axis as values ranging into the millions, percentage values ranging between 0 and 
100 would hardly be noticeable. In the chart, separate y-axes allow percentages to 
carry comparable analytical weight.

➤ To proceed to the next report, click the Product Share report tab.

Product Share
The Product Share report feature uses multiple pie charts to illustrate product share 
in each market region. Reports of this nature are commonly used for Contribution 
analysis.

Figure 63: Product Share Report
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Key Features
Simultaneously displaying many charts is powerful, even when a single chart type 
is used.

➤ To rotate a pie chart, click and drag a pie wedge in a circular motion.

➤ To separate wedges, take one of the following actions:

● Right-click and drag a pie wedge.

● Select a pie chart and press Page Up or Page Down.

➤ To drill down through the dimensional hierarchy, double-click a wedge.

➤ To proceed to the next report, click the Product Budget report tab.

Product Budget
The Product Budget report is a midyear spreadsheet report combining Actual and 
Budget dimension members for a projection of the year. Significant in this report 
is the use of asymmetrical analysis, a common aspect of financial reporting.
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Figure 64: Product Budget Report

Key Features
Asymmetrical analysis reports feature nested dimensions that differ (by at least 
one member) across an axis. Differences can be in the number of members or in 
the names of the members, but whatever the cause, dimension member symmetry 
has been abandoned.

Hyperion Analyzer accommodates asymmetrical analysis by enabling you to hide 
specified rows, columns, and chart objects.
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➤ To proceed to the next report, click the Sales Forecast report tab.

Sales Forecast
The Sales Forecast report contains a coordinated spreadsheet and chart that enable 
you to project sales and budget figures, apply them to the OLAP database, and 
appraise their consequences in real time.

Figure 65: Sales Forecast Report

Key Features
Authorized users can edit cell values and write edits back to Hyperion Essbase.

You can initiate Edit Data Mode only from the spreadsheet display type.
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The Edit Data Bar is displayed at the bottom of the Main Display panel when you 
are in Edit Data Mode.

➤ To edit data values:

1. Right-click any spreadsheet cell and select Edit Data.

The Edit Data Bar is displayed in the spreadsheet data object.

2. Double-click a cell to edit its data value.

The cell border becomes gray, and cell formatting is disabled.

3. Enter a new data value, and click outside the cell.

4. Click the Send/Commit button on the Edit Data bar.

Only authorized users can successfully write changes to the database. The 
Confirmation dialog box is displayed if write-back is successful.

5. Optional: If the database contains calculated members, you can recalculate 
the database by clicking the Calculate button.

6. Click the Close/Disable button to exit Edit Data mode.

➤ To close the entire report group with a single click, right-click any report tab and 
select Close All.
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8

Chapter

8
Creating Your First Report

You have two options for creating new reports:

● Modify an existing report, and save the report under a new name or to a new 
report group.

● Use the new report creation wizard.

This chapter leads you through the process of creating a Hyperion Analyzer report 
using the Java Web Client.

For a description of creating a new report using the HTML Web Client, see 
“Creating a Report in the HTML Web Client” on page 84.

Overview of New Report Creation
The creation of our new report includes the following series of procedures:

1. Starting the Hyperion Analyzer Java Web Client

2. Starting the New Report Creation Wizard

a. Selecting a display type

b. Selecting a database connection

c. Defining a query with the Cube Navigator

d. Defining dimension member selections with the Dimension Browser

3. Saving a report

4. Formatting a spreadsheet

5. Creating a Traffic Lighting definition

6. Creating a calculated member

7. Saving the report as a Web Page
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Starting the Hyperion Analyzer Java Web Client
If you have not yet started the Hyperion Analyzer Java Web Client, see “Starting 
the Hyperion Analyzer Java Web Client” on page 33.

Starting the New Report Creation Wizard
Hyperion Analyzer provides an automated series of dialog boxes that steps you 
through the process of laying out a report, composing an OLAP query, and 
defining dimension member selections.

➤ To initiate the new report creation wizard, click the New toolbar button.

Figure 66: Toolbar New Button

Selecting a Display Type
The Select Layout dialog box, the first step in the wizard process, prompts you to 
select a display type for the report you are creating.

Figure 67: Select Layout Dialog Box

You can select spreadsheet or chart, but not pinboard. This is because pinboard 
display types require a spreadsheet with a traffic lighting definition to be created 
first. Pinboards are created with the Pinboard Designer.
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There are also Vertical Combination and Horizontal Combination layout options. 
These options construct a report that has both a spreadsheet and chart.

The last option is to create a Custom Report. For more information, see Chapter 9, 
“Creating a Dynamic Custom Report”.

➤ To select the Spreadsheet display type, click the Spreadsheet icon and then click 
OK.

Selecting a Database Connection
The Select Database Connection dialog box, the second action in the wizard 
process, prompts you to select a Hyperion Essbase, Hyperion Financial 
Management, or relational database connection. The server you select is queried 
for report data values.

Figure 68: Select Database Connection Dialog Box

Each database connection type has a unique icon.

Figure 69: Global Database Connection and Personal Database Connection Icons

Global database connections are defined by Administrators and are available to all 
users with permission. You create personal database connections for your own 
analysis. Personal database connections are only available to you.

You can sort the list of database connection names in ascending or descending 
order by clicking the arrow in the Name column header.
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➤ To select a database connection, click the database connection name and then click 
OK.

Note: For the purposes of this tutorial, select the Hyperion Essbase Sample Basic 
global database connection. Because Administrators can rename database 
connections, check with your Administrator if you are unsure of the database connection 
name.

Cube Navigator
The Cube Navigator dialog box, the third action in the wizard process, is a 
graphical interface for laying out a report and defining a database query.

Figure 70: Cube Navigator

When you select a database connection, Cube Navigator lists dimensions, 
attributes and calculations defined in that database outline.

Figure 71: Dimension, Attribute, and Calculated Dimension Icons
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All dimensions are presented as aggregates on the Filters axis by default.

There are also panels for the Page, Columns, and Rows axes.

Dragging dimensions, attributes, or calculated dimensions to another axis initiates 
the process of creating a query and assigns the dimension to that axis in the report 
layout.

Defining Dimension Member Selections with the 
Dimension Browser

When a dimension is dragged to another axis, the Dimension Browser dialog box 
is displayed. The Dimension Browser dialog box is used for defining dimension 
member selections. Selecting specific dimension members enables the query, and 
subsequently the report, to provide more detailed information.

Figure 72: Dimension Browser

You can perform the following tasks using the Dimension Browser:

● Expand and collapse the dimension hierarchy.
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● Select individual dimension members.

● Select dimension members using familial relationships.

● Select dimension members in terms of the multidimensional hierarchy.

● Select dimension members from server-specific definitions.

● Select dimension members from pre-defined selection lists.

● Indicate a label mode for the dimension.

● Remove dimension members from the selection.

➤ To expand or collapse the dimension hierarchy, click the plus sign (+) or minus 
sign (-), or double-click the dimension member name.

➤ To make dimension member selections, expand the dimension hierarchy and click 
dimension member checkboxes. Selected dimension members display in the 
Selections panel at right.

Dimension Browser enables you to select the label mode for the dimension, using 
a group of option buttons. You can display the member description, the unique ID, 
or defer to default user preferences.
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Dynamic Member Selection
In dimensions with large member sets, you can easily define member selections 
using the Dimension Browser right-click menu. Right-clicking dimension member 
names enables selection by familial relationship and database-specific selection 
options.

Figure 73: Dimension Browser Right-click Menu (Essbase:Sample:Basic)

The advanced member selections are dynamic. This means that as long as the 
right-clicked dimension member exists in the database outline, the advanced 
member selection is applied regardless of how the outline grows, shrinks or is 
redefined. This prevents your work from becoming obsolete and enables changes 
in the data source to be reflected in the report.

Defining the Query
You jump between Cube Navigator and Dimension Browser until you define all 
dimension positions and member selections.
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Defining the Year Dimension

➤ To position the Year dimension in the report layout and define dimension member 
selections, do the following:

1. Drag the Year dimension to the Columns panel.

Dropping the dimension on the axis panel opens the Year Dimension Browser.

2. Click the Year plus sign (+), to expand the dimension hierarchy.

The children of Year are displayed.

3. Click the check boxes to select the four quarters (Q1, Q2, Q3, and Q4).

4. Click OK.

The Cube Navigator resumes focus.

Defining the Scenario Dimension

➤ To position the Scenario dimension in the report layout and define dimension 
member selections, do the following:

1. Drag the Scenario dimension to the Columns panel.

Dropping the dimension on the axis panel opens the Scenario Dimension 
Browser.

2. Select Actual and Budget from the Scenario dimension.

3. Click OK.

The Cube Navigator resumes focus.

Defining the Product Dimension

➤ To position the Product dimension in the report layout and define dimension 
member selections, do the following:

1. Drag the Product dimension to the Rows panel.

Dropping the dimension on the axis panel opens the Product Dimension 
Browser.

2. Right-click the Product dimension name and select Also Select Children.
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This selection includes the Product member and members immediately 
beneath it in the dimension hierarchy.

3. Click the Show Descriptions option button.

4. Click OK.

The Cube Navigator resumes focus.

Defining the Market Dimension

➤ To position the Market dimension in the report layout and define dimension 
member selections, do the following:

1. Drag and drop the Market dimension to the Rows panel.

The Market Dimension Browser is displayed.

2. Click the Market plus sign (+), to expand the dimension hierarchy.

3. Right-click the Central dimension member and select Also Select Level.

All Market dimension members at the same level as Central (all regions) are 
selected.

4. Click OK.

The Cube Navigator resumes focus.

Defining the Measures Dimension

➤ To position the Measures dimension in the report layout and define dimension 
member selections:

1. Drag the Measures dimension to the Pages panel.

The Measures Dimension Browser is displayed.

2. Select the Sales dimension member (+Measures > +Profit > +Margins > 
Sales).

Placing Sales measures on the Page axis ensures that all report intersections 
are relevant to Sales figures.

3. Click OK.

The Cube Navigator resumes focus.
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Defining the Package Type Dimension

➤ To position the Pkg Type dimension in the report layout and define dimension 
member selections:

1. Drag the Pkg Type dimension to the Pages panel.

The Pkg Type Dimension Browser is displayed.

2. Right-click Pkg Type and select Also Select Children.

This selection organizes the query result set into pages by the children of the 
Package Type attribute dimension. Because Sales measures are also on the 
Page axis, all report intersections are relevant to Sales figures and the current 
package type.

3. Click OK.

The Cube Navigator resumes focus.
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Cube Navigator Options
The options under the Cube Navigator Options button menu enable you to specify 
report parameters prior to submitting the database query.

Figure 74: Cube Navigator

Submitting the Query
All the dimensions are positioned and dimension member selections have been 
defined. It is time to submit the query to the data source, using the selected 
database connection.

➤ To submit the OLAP query to the multidimensional database, click the Cube 
Navigator OK button.
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The requested data values are returned and presented per the query parameters.

Figure 75: The Created Report

You have created your first report.

Saving a Report
To save the report you created to the Hyperion Analyzer repository, you must use 
the Save As command.

➤ To save the report you created:

1. Take one of the following actions:

● Click the Save As Toolbar button.

● Select Save As from the Report Tab right-click menu.

● Select File > Save As from the menu bar.
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The Save Report dialog box is displayed.

2. Enter the following information in the Save Report dialog box:

Report Name: First Report

Group: First Report Group

3. Click OK.

Saving a report stores the query, dimension member selections and formatting 
definitions that compose the report to the Hyperion Analyzer repository. The data 
values populating multidimensional intersections are returned from the database 
connection each time the report is opened.

Formatting a Spreadsheet
Use the Spreadsheet Options dialog box to apply formatting to the spreadsheet 
display type. You can set the following options:

● Background color.

● Row banding color.

● Header font style.

Setting the Background Color

➤ To set the spreadsheet background color:

1. Right-click the Qtr1 dimension label, and select Spreadsheet Options.

The Spreadsheet Options dialog box is displayed.

2. In the Display group box, click the Background Color button.

The Select Color dialog box is displayed.

3. On the Swatches tab, click the color you want to use for the background.

4. Click OK.

The Spreadsheet Options dialog box resumes focus.

5. Click OK.
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Setting the Row Banding Color

➤ To set the spreadsheet row banding color:

1. Right-click the Qtr1 dimension label, and select Spreadsheet Options.

The Spreadsheet Options dialog box is displayed.

2. In the Display group box, click the Row Band Color button.

The Select Color dialog box is displayed.

3. On the Swatches tab, click the color you want to use for an alternating row 
band.

4. Click OK.

The Spreadsheet Options dialog box resumes focus.

5. Click OK.

Setting the Header Font

➤ To set the font style for the dimension label headers:

1. Right-click the Qtr1 dimension label, and select Spreadsheet Options.

The Spreadsheet Options dialog box is displayed.

2. In the Headers group box, select the Header Font button.

The Font Properties dialog box is displayed.

3. In the Font Style group box, click the Bold check box.

4. In the Size text box, type 12 for the font point size.

5. Click OK.

The Spreadsheet Options dialog box resumes focus.

6. Click OK.

Creating a Traffic Lighting Definition
The Traffic Lighting analysis tool color codes dimension member cells, based on 
a comparison of two dimension members, or on fixed limits for a single dimension 
member.
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Traffic lighting graphically associates member values, whether or not they are 
sorted or ranked.

Use the Traffic Lighting dialog box to perform the following tasks:

● Compare Actual measures to Budget measures.

● Set colors to identify percentage differences.

● Make the traffic lighting semi-transparent.

Defining a Traffic Lighting Definition

➤ To define a traffic lighting definition:

1. Right-click the Actual dimension member label and select Analysis Tools > 
Traffic Light.

The Traffic Lighting dialog box is displayed.

2. In the Apply Traffic Lighting To panel, click Actual.

3. In the Comparing It To panel, click Budget.

The Traffic Lighting definition compares Actual measures to Budget 
measures.

Variance limits determine the thresholds and ranges to which traffic lighting 
colors are applied. These limits can be set by fixed differences, or by 
percentage differences.

4. In the Assign Limits group box, select the % Differences check box.

There are three default ranges and colors. You can enter values to define 
thresholds for the ranges.

5. In the Assign Limits group box, set the threshold for the top set-point to 10.

This sets Budget data values greater than 10 percent of the Actual data values 
to have the cell background color used by the top range.

6. In the Assign Limits group box, set the threshold for the second set-point to 
-10.

This sets Budget data values greater than -10 percent of the Actual data values 
to have the cell background color used by the middle range. Budget data 
values less than -10 percent of the Actual data values have the cell background 
color used by the bottom range.
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7. Click the Apply button.

Setting Traffic Lighting Range Colors

➤ To set Traffic Lighting range colors, perform the following tasks:

1. Right-click the top color range and select Set Color.

The Select Color dialog box is displayed.

2. On the Swatches tab, click the color you want to use for the top range.

3. Click OK.

The Traffic Lighting dialog box is displayed.

4. Right-click the middle color range and select Set Color.

The Select Color dialog box is displayed.

5. On the Swatches tab, click the color you want to use for the middle range.

6. Click OK.

The Traffic Lighting dialog box is displayed.

7. Repeat steps 1-6 for the bottom range.

The Traffic Lighting dialog box is displayed.

8. Optional: To include the threshold in the range above it or below it, right-click 
the threshold arrow and select the corresponding range color.

9. Click the Apply button.

Setting Transparency for Traffic Lighting Ranges
Controlling traffic lighting transparency is important, when you do not want a 
background image to be obscured by cell traffic lighting.

➤ To set transparency for traffic lighting ranges:

1. Right-click the middle color range and select Set Opacity.

The Opacity dialog box features a slider controlling the percentage of 
transparency, and a Apply to All Colors check box. When the slider is set to 
100, the range is opaque. When the slider is set to 0, the range is completely 
transparent.
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2. Drag the slider control to 50.

The traffic lighting range is 50% transparent.

3. Click the Apply To All Colors check box.

The 50% transparent setting is applied to all ranges.

4. Click OK.

The Traffic Lighting dialog box reflects the setting.

5. Click OK.

The traffic lighting definition is applied to the report.

Figure 76: Your First Report with Traffic Lighting

Creating a Calculated Member
Hyperion Analyzer enables you to define client-based calculations that are 
maintained as dimensions members and values fluctuate.

Use the Calculation Definition dialog box to create the following calculated 
members:

● Variance - The difference between Actual and Budget scenarios
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● %Variance - The percentage difference between Actual and Budget scenarios

Defining a Variance Calculation Definition

➤ To define a variance calculation definition:

1. Right-click the Actual dimension member label and select Analysis Tools > 
Calculation.

The Calculation Definition dialog box is displayed.

2. In the Name text box, type Variance.

3. From the Function drop-down list box, select Subtract.

4. In the Select Position group box, select the Insert After option button, and 
select Budget from the Insertion Point drop-down list.

You have created a subtraction calculation called Variance and positioned the 
calculated member in the report after the Budget dimension.

Notice in the Equation panel at the bottom of the dialog box, that the 
subtraction function has two arguments. Two question mark placeholders 
occupy the Arguments panel.

5. In the Select Members panel, click Actual and then click the right-arrow.

Actual is moved to the Arguments panel as the first argument.

6. In the Select Members panel, click Budget and then click the right-arrow.

Budget is moved to the Arguments panel as the second argument. The 
Equation panel displays the subtraction function with both members as 
arguments.

7. Click Apply.

8. Click OK.

Defining a Percent Variance Calculation Definition

➤ To define a percent variance calculation definition:

1. Right-click the Actual dimension member label and select Analysis Tools > 
Calculation.

The Calculation Definition dialog box is displayed.
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2. In the Name text box, enter %Variance.

3. From the Function drop-down list box, select Percent.

4. In the Select Position group box, select Insert After, then select Variance 
from the Insertion Point drop-down list.

You have created a percentage calculation called %Variance and positioned 
the calculated member in the report after the other calculated dimension.

The Equation panel requires two arguments for the percent calculation.

5. In the Select Members panel, click Actual and then click the right-arrow.

Actual is moved to the Arguments panel as the first argument.

6. In the Select Members panel, click Budget and then click the right-arrow.

Budget is moved to the Arguments panel as the second argument.

7. Click Apply.

8. Click OK.

Figure 77: Your First Report with Traffic Lighting and Calculations

Your first report now displays two calculated columns.
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Saving the Report as a Web Page
Now that you have created your first report, you can share it with others. Your 
Hyperion Analyzer report can be easily saved to HTML.

You use the Report Properties dialog box to set parameters for the Save As Web 
Page process, and then you can publish to the Web.

You can use this same process to publish entire report groups to the Web.

Figure 78: Report Properties Dialog Box
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Setting Save As Web Page Parameters

➤ To set parameters for the Save As Web Page process:

1. Right-click the report tab for the current report and select Report Properties.

The Report Properties dialog box is displayed. 

2. Identify the JSP template used to generate the Web page by taking one of the 
following actions:

● In the JSP Template text box, enter the name and file extension of a JSP 
template on the Hyperion Analyzer server.

● Click the Browse button and navigate through the network to a JSP 
template on the Hyperion Analyzer server.

● Leave the text area blank to use the Hyperion Analyzer default JSP 
template.

Note: There is no need to specify an output directory for the Publish To text box. 
The output directory is only used in conjunction with the Save as Web Page Batch 
Utility. See Hyperion Analyzer Administration Tools Online Help for more 
information.

3. Click OK.

The parameters for the Save As Web Page process are set, and they are stored 
in the report definition upon the next save.

Publishing the Report to the Web

➤ To save the current report to HTML:

1. Select File > Web Publish > Current Report.

The Save dialog box is displayed.

2. Navigate to a network location where the HTML output can be saved, and 
click OK.

Hyperion Analyzer uses the parameters specified in the Report Properties 
dialog box to convert the report to HMTL and locate the output.

You have created and formatted your first report, applied advanced analysis tools, 
and distributed it to the World Wide Web.
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9

Chapter

9
Creating a Dynamic Custom 
Report

You are not restricted to creating reports with the report creation wizard. Hyperion 
Analyzer also provides an innovative interface for designing custom reports.

This chapter leads you through the process of creating a Hyperion Analyzer 
custom report using the Java Web Client.

Although HTML Web Client users can review custom reports, they cannot create 
custom reports.

The following tutorial assumes you are familiar with multidimensional analysis, 
the Hyperion Analyzer interface, and the conventions associated with creating a 
standard Hyperion Analyzer report. If you are not familiar with these topics, 
review Chapter 2 through Chapter 7.

Overview of Creating a Custom Report
The creation of your custom report includes the following procedures:

1. Starting the Hyperion Analyzer Java Web Client

2. Starting Design Report Mode

3. Overview of the Design Report Interface

4. Overview of the Component Toolbar

5. Creating a Main Report Panel

6. Setting the Panel Background Color

7. Dragging a Spreadsheet Data Object

8. Moving a Component

9. Creating a Dynamic Text Label

10. Sizing a Component
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11. Adding a Chart Data Object

12. Aligning Components

13. Creating a Selection Control

14. Formatting a Component Border

15. Creating a Hotspot

16. Returning to Normal Mode

Starting the Hyperion Analyzer Java Web Client
If you have not yet started the Hyperion Analyzer Java Web Client, see “Starting 
the Hyperion Analyzer Java Web Client” on page 33.

Starting Design Report Mode
Custom reports are created in Design Report mode. There are two methods for 
starting Design report mode:

● Import existing reports from Normal mode to Design Report mode, by 
selecting Tools > Design Report from the Tools Toolbar button drop-down 
menu.

Figure 79: Toolbar Tools Button and drop-down Menu
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● Use the new report creation wizard to create a new custom report.

Figure 80: Toolbar New Button

You use the second option in this tutorial.

➤ To initiate Design Report mode using the new report creation wizard, perform the 
following tasks:

1. Click the New toolbar button.

The Select Layout dialog box is displayed.

2. Click the Custom Report icon, and then click OK.

Figure 81: Select Layout Dialog Box
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Design Report Interface
Design Report mode is an interface for creating custom reports.

Figure 82: Hyperion Analyzer Design Report Mode

It has the following components:

● Application window title bar

● Menu bar

● Design Report toolbar

● Component toolbar

● Report panel

● Status bar
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Component Toolbar
Hyperion Analzyer provides an inventory of coding-free components that you can 
include in your custom report. There are 19 different components that be used any 
number of times and customized any number of ways. The combination of options 
provides almost unlimited creative opportunities for custom report designers.

Figure 83: Design Report Mode Component Toolbar

Each component is represented by an icon on the component toolbar:

Icon Component Description

Panel Creates an empty container for dividing 
space in the report.

Split panel Creates two coordinated panels separated 
by a splitter bar.

Label Creates a transparent text label for use as 
a title, label, or caption.

Text area Creates a dynamic text box used for 
annotating reports.

Image Creates a graphic panel, enabling you to 
include graphic backgrounds, pictures, 
illustrations and hotspots.

HTML browser Creates a pane for browsing static 
HTML.

Chart data object Creates a data object and assigns the 
chart display type.

Spreadsheet data object Creates a data object and assigns the 
spreadsheet display type.

Pinboard data object Creates a data object and assigns the 
pinboard display type.

Combo box subscription Creates a combo box (drop-down list 
box) coordinated with other objects in 
the report.
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You use several of these custom report components in this tutorial.

If you forget what the many icons mean, you can always float the cursor over a 
component icon and read the pop-up hint. 

Radio button group 
subscription

Creates a set of option buttons 
coordinated with other objects in the 
report.

Checkbox group subscription Creates a set of check boxes coordinated 
with other objects in the report.

Tab group subscription Creates a set of tab controls coordinated 
with other objects in the report.

Multi-level combo box 
subscription

Creates multiple cascading combo boxes 
coordinated with other objects in the 
report.

Slider subscription Creates a slider bar coordinated with 
other objects in the report.

Selection button subscription Creates a selection button coordinated 
with other objects in the report.

Alias controller Creates a drop-down list box enabling 
you to select the Label mode for a 
coordinated data object.

Services button Creates a services button, enabling you to 
execute one of many Hyperion Analyzer 
actions.

SQL spreadsheet data object Creates a spreadsheet data object for 
which you can compose their own 
relational SQL query.

SQL spreadsheet subscription Creates a combo box (drop-down list 
box) coordinated with a SQL spreadsheet 
object in the report.

Icon Component Description
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Creating a Main Report Panel
First, you create a main report panel. It serves as a container for all other report 
components.

➤ To create a main report panel:

1. Drag a Panel component from the component toolbar to the Main Display.

Figure 84: Panel Component Icon

The Select Graphic dialog box is displayed, prompting you to select a graphic 
background for the container. 

2. Click Color.

The Select Color dialog box is displayed.

3. On the Swatches tab, click a color to use for the report background.

4. Click OK.

5. In the Select Graphic dialog box, click OK.

The report features a colored panel. 

Setting the Panel to Fill Slack Space

➤ To size the panel to fill all slack space, right-click the panel component and select 
Anchor > Slack.

The colored panel covers the entire report area. The Slack setting sets the panel 
component to fill all available space, regardless of the screen size or window size 
of subsequent users.

Selected Components
The panel is currently selected. When selected, custom report components feature 
a blue outline and handles at midpoints and corners.
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Adding a Spreadsheet Data Object

➤  To create a spreadsheet data object:

1. Drag a Spreadsheet component from the component toolbar to the main 
display area.

Figure 85: Spreadsheet Component Icon

Data objects, such as this spreadsheet, require properties to be set. The Data 
Object Properties dialog box prompts you to perform the following tasks:

● Identify a data source (or query)

● Confirm the display type

Because no existing data source exists, you must create a new data source.

2. Click the New Data Source line item, and follow the new report creation 
wizard through the process of designing a query.

Because the Spreadsheet option button is selected, do not change the display 
type.

3. Click OK.

Clicking OK initiates the same new report creation wizard used in the last 
tutorial. You have to identify a database connection, use Cube Navigator to lay 
out the report and make dimension member selections with the Dimension 
Browser. For more information on the new report creation wizard, see 
Chapter 8, “Creating Your First Report”.

After you click the Cube Navigator OK button, the Spreadsheet data object is 
displayed on the main report panel.

Moving a Component

➤ To move a custom report component:

1. Click the component to give it focus.

2. Position the cursor over the component until the cursor changes to resemble a 
compass.
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3. Drag the component, being careful not to grab an outline handle.

Handles are used to resize the component. If you drag a handle, you change 
the shape of the spreadsheet data object.

Adding a Dynamic Text Label
You can create a label for the spreadsheet data object.

➤  To create a dynamic text label:

1. Drag and drop a label component from the component toolbar to the main 
display area.

Figure 86: Label Component Icon

The Insert Text dialog box is displayed, prompting you to enter the text for a 
static text label. Static text is entered text that remains fixed.

You can create a dynamic text label too. Dynamic text is text that updates to 
reflect the latest information.

Dynamic text is generated by including special tags in a text label. These tags 
are replaced with values when the report is displayed in Normal mode.

2. Type the static text “Report Name:” and a space.

3. Right-click after the space and select Report Name.

4. Click OK.

A dynamic text label displays on the main report panel with the spreadsheet. 
Notice that it contains both the static text and the current name of this report. 
When you save the report under a new name, the dynamic text label reflects 
the change.
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Resizing Components

➤ To resize the label, click to select the component and then drag outline handles.

Adding a Chart Data Object

➤  To create a chart data object, perform the following tasks:

1. Drag a Chart component from the component toolbar to the Main Display.

Figure 87: Chart Component Icon

Just like the Spreadsheet data object, the Data Object Properties dialog box 
prompts you to perform the following tasks:

– Identify a data source (or query)

– Confirm the display type

2. Click the same data source used by the spreadsheet data object.

Data objects that share common data sources are coordinated. This means that 
as you navigate one data object, coordinated data objects reflect the same 
navigation.

Note: If you are not sure if you have selected the same data source as the 
spreadsheet data object, you can right click the chart component, select 
Properties, and select a different data source.

Because the Chart option button is selected, do not change the display type.

3. Click OK.

The Chart data object displays on the main report panel with the spreadsheet 
and label.

Aligning Components
You can neaten the layout of these components using the following options:
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● Component Right-click Menu > Anchor - fixes the component to an edge of 
the panel containing it. Also enables you to set the component to fill slack 
space, or have no fixed position.

● Component Right-click Menu > Alignment - positions components relative to 
specific edges or center points. Requires at least two components to be 
selected.

● Component Right-click Menu > Distribution - spaces components relative to 
specific edges or center points. Requires at least three components to be 
selected.

● Drag and Drop - manually moves the component on the report.

● Shift + Arrow Keys - moves the component in an ordinal direction (up, down, 
left, or right) one pixel at a time. 

 Aligning Your Components

➤ To align the three report components on your panel:

1. Press and hold Ctrl and click the three components: label, spreadsheet, and 
chart.

Make sure the main report panel is not selected. If it is, click to deselect it.

2. Right-click any of the selected components and select Alignment > Left 
Edges.

The left edge of all three components should align vertically. 

You can move all three selected components as a set.

3. Locate the cursor over one of the components until it changes to resemble a 
compass, then drag the group of components to the left side of the main report 
panel.

4. Click one of the components.

The other two components are deselected.

5. To move the component vertically, press Shift and the up and down arrow 
keys.

In this way you maintain the relative position inside the panel, and the left 
edge alignment, but can space the overlapping components.



140 ■

Creating a Dynamic Custom Report

Hyperion Analyzer Getting Started

Movement is one pixel at a time, so you may have to press repeatedly to move 
components longer distances.

6. When the first component is in the position you want, click the second 
component and repeat the process of moving the component vertically: Press 
Shift and the up and down arrow keys.

If a component, completely obscures another component, right-click the 
component on top and select Send to Back.

7. Repeat this process for the third component.

The main report panel should now contain a chart, spreadsheet and label that 
are aligned on the left side of the panel.

Creating a Selection Control
You can create a control that enables you to specify the dimension members 
displayed in data objects.

➤ To create a radio button group subscription:

1. Drag a Radio Button Group component from the component toolbar to the 
right side of the main display area.

Figure 88: Radio Button Group Subscription Component Icon

Subscription and selection controls require many properties to be set. As a 
result the subscription button object uses a series of dialog boxes to perform 
the following tasks:

● Identify a data source (or query)

● Select a dimension

● Define dimension member selections

● Select subscription control options

The Select Data Source dialog box is displayed.

2. Click the same data source used by the spreadsheet and chart data objects, and 
click OK.



Creating a Dynamic Custom Report

9

■ 141Hyperion Analyzer Getting Started

Components that share common data sources are coordinated.

Note:  If you are not sure if you have selected the same data source as the 
spreadsheet and chart data objects, you can right click the component, select 
Properties, and select a different data source.

The Select Dimension dialog box is displayed.

3. Click to select the Product dimension and then click OK.

The Select Members dialog box is displayed.

4. Click the Add button to specify dimension member selections.

The Product Dimension Browser is displayed.

5. To expand the Product dimension hierarchy, click the plus sign (+).

6. Right-click Colas and select Also Select Descendants.

7. Right-click Diet Drinks and select Also Select Descendants.

8. Right-click Root Beer and select Also Select Descendants.

9. Click OK.

The Select Members dialog box is displayed again. 

10. Click the three Dynamic check boxes in the Members panel.

11. Click the Indent Members check box at left.

12. Click OK.

The radio button group is displayed on the main report panel. You may need 
to size the panel to accommodate your dynamic member selections. Notice 
that the text labels are indented to reflect the dimension hierarchy.

Formatting a Component Border
You can give more emphasis to the radio button group subscription by formatting 
the component border.

➤ To format a component border:

1. To set the border style, right-click the radio button group and select Border > 
Line.

2. Right-click the radio button group and select Border > Set Border Color.
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The Select Color dialog box is displayed.

3. On the Swatches tab, click the cell of a color for the component border color, 
then click OK.

4. Right-click the radio button group and select Border > Set Border Size.

The Enter Border Thickness dialog box is displayed.

5. Type a border width in pixels of 5, and click OK.

The radio button group now has a line border that is five pixels wide and features 
the color you selected.

Creating a Hotspot
A hotspot is a graphic image used to trigger a Hyperion Analyzer action. Hotspots 
are constructed by positioning transparent Services buttons over a graphic image.

Creating an Image Panel

➤ To create an image panel:

1. Drag an Image component from the component toolbar to the right side of the 
Main Display.

Figure 89: Image Component Icon

The Select Graphic dialog box is displayed.

2. Click Load. 

The Open dialog box is displayed, prompting you to navigate and select a GIF 
or JPG format file.

3. Navigate to a GIF or JPG file and click Open.

The Select Graphic dialog box is displayed again, with the selected graphic 
displayed in a panel.

4. Click OK.

A panel containing the graphic displays on the main report panel.
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Creating a Services Button

➤ To create a Services button:

1. Drag a Services component from the component toolbar to the right side of the 
Main Display area.

Figure 90: Services Component Icon

The Services Properties dialog box is displayed, enabling you to select from a 
wide variety of Hyperion Analyzer actions.

2. Click the Open Report option button.

The Report Manager dialog box is displayed.

3. Select the First Report Group at left, and the First Report report on the 
right, then click OK.

The Services Properties dialog box is displayed again. Notice that Open 
Report is displayed in the Enter Text Label text box. You can edit this text as 
desired.

4. Click OK.

The Services button displays on the main report panel.

Making the Services Button Transparent

➤ To make the Services button transparent, right-click the Services button 
component and deselect the Opaque check box.

Moving the Transparent Services Button Over the Image 
Panel

➤ To complete the hotspot:

1. Click the transparent services button component.

Position the cursor over the component until the cursor changes to resemble a 
compass.

2. Drag the Services component over the Image panel.
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If the Services button is not the top layer, right-click the Image panel and 
select Send to Back.

You have created a graphic hotspot that opens your First Report.

Returning to Normal Mode
When you are finished designing the custom report, you can return to the Normal 
mode and review your work.

➤ To return to Normal mode, click the Normal View toolbar button.

Figure 91: Design Report Mode Normal View Toolbar Button
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Chapter

10
Overview of Advanced 
Features

This chapter introduces and groups additional Hyperion Analyzer features that 
may interest you. See Hyperion Analyzer online help for more information.

Analyzing Anywhere
Hyperion Analyzer enables large numbers of users to access analysis applications 
anywhere they use a Web browser.

Highest Scalability and Performance
Hyperion Analyzer has been redesigned to run inside leading J2EE-compliant 
application servers. This provides Hyperion Analyzer users the highest level of 
reliability, stability, scalability, and performance in the industry, and it leverages 
their existing enterprise application server technology.

Open- and Cross-Platform
Hyperion Analyzer harnesses the power and performance of open systems 
platforms, including Microsoft Windows NT, IBM AIX, Sun Solaris and HP-UX.

Completely Web-Based
The powerful analysis functionality of Hyperion Analyzer is now available on the 
Web, using the 100-percent Java-based Hyperion Analyzer Java Web Client. 
Web-based functionality includes designing functionality previously offered by a 
separate Designer application and the ability to leverage Hyperion Essbase server 
features using Hyperion Analyzer clients. 
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In keeping with this Web-based strategy, Hyperion Analyzer Administration Tools 
has been redesigned into a 100-percent Java application as well. This enables 
administrators to manage users, user groups, and database connections anywhere 
they can access the Internet.

There is also a 100-percent HTML thin client, the Hyperion Analyzer HTML Web 
Client.

Java Application for Microsoft Windows
The Hyperion Analyzer Standalone Client is the same easy-to-use Java Web Client 
interface and functionality delivered as a Java application for supported Microsoft 
Windows operating systems.

Sophisticated Graphical User Interfaces
Hyperion Analyzer features many easy-to-use graphical user interfaces.

Report Creation Wizard
The Report Creation Wizard guides users through the process of creating reports 
by prompting them through a sequence of dialog boxes. To begin creating new 
reports, click the New toolbar button.

The Report Creation Wizard displays the Select Layout dialog box, the Select 
Database Connection, the Cube Navigator and the Dimension Browser in order, 
until a database query has been defined, submitted and returned.

Cube Navigator
Cube Navigator is a graphic interface for composing multidimensional queries.

To create a query, users drag and drop dimension icons onto report axes panels. 
When dimensions are located, the corresponding Dimension Browser is displayed 
to expedite dimension member selection.

Users can edit existing cubes with Cube Navigator or create entirely new cubes. 
Users can even query attribute dimensions in this same manner. Cube Navigator is 
displayed either as part of the Report Creation Wizard, or when users click the 
Navigate toolbar button.
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Dimension Browser
The Dimension Browser is a graphic interface for composing dimension member 
selection statements. When dimensions are located to report axes, users are 
prompted to select specific dimension members for the query.

As with the Cube Navigator, there is nothing more to selecting dimension 
members than clicking member names.

The Dimension Browser right-click menu enables advanced member selection. 
Users can select members based on the following criteria:

● Familial relationships

● Database-specific selection options

● Member subsets

● Substitution variables

● Personal variables

● A member selection search

Using member selection statements also enables dynamic query result sets. When 
a report is loaded, all dimension members satisfying the member selection 
definition are returned, even as individual members are renamed, deleted, or 
added. This is particularly advantageous in large dimensions.

Custom Reports
Users can now create sophisticated custom reports in a programming-free 
environment, without leaving the Hyperion Analyzer Java Web Client.

To create a custom report, users initiate Design Report mode. Design Report mode 
is a graphic interface for designing custom reports, that enables users to drag a 
selection of components onto an empty report panel.

Users can initiate Design Report mode from the Tools menu, from the Tools 
toolbar button, or by selecting Custom from the Select Layout dialog box.

New Undo and Redo functionality in Design Report mode enables report designers 
to remove and recover interface components with the click of the mouse.

Text labels can be defined using dynamic tokens, variables that are replaced with 
actual values at run time. There are tokens for the following objects: cell reference, 
report description, report name, connection name, current time, user ID, user 
name, filter dimension, and page dimension.
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Transparent Spreadsheets
Background graphics can now be added to Hyperion Analyzer spreadsheets, 
enabling a higher level of customization and design.

Flexible Formatting
Users can further customize and format reports using Spreadsheet Options, 
Pinboard Designer, and Chart Properties (located on the right-click menu).

Spreadsheet Options
The Spreadsheet Options dialogue box provides a central interface for formatting 
the spreadsheet display type.

Pinboard Designer
Pinboard options trigger a Pinboard Designer wizard, which prompts users 
through the process of creating a Pinboard display type.

Pinboard options include the following items:

● Background graphic

● Pin behavior

● Pin graphic

● Active Color

● Pin location

● Dimensions represented

Chart Properties
The Chart Properties dialog box provides a central interface for formatting all chart 
aspects.

Hyperion Analyzer chart objects now support gradation between two colors, using 
icon gif images as markers, and Spline, Box Plot, Bubble and Curve Area chart 
types.
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Asymmetrical Analysis
Hyperion Analyzer accommodates asymmetrical analysis by enabling users to 
hide specified rows, columns, and chart objects.

Multiple Charts
Hyperion Analyzer enables multiple charts to be displayed inside a single chart 
object, thus simplifying chart comparisons.

Secondary Y-axis
Charts can display a second y-axis. Parallel axes enable information to be scaled 
independently, but displayed alongside other dimensions.

Personalizing Information
Hyperion Analyzer takes user-customization to a new level.

Personalized Look and Feel
Users can customize the Hyperion Analyzer display and behavior with user 
preferences. User preferences are global settings applied to all reports. These 
default settings are stored in Hyperion Analyzer repository tables.

Personalized Database Connections
Users can define their own user-friendly database aliases. In addition to 
simplifying long identifiers, database connection names enable databases to be 
maintained on multiple servers. Users can create, maintain, and edit database 
connections from the Connections User Preferences tab.

Personal Variables
Personal Variables enable users to define and name complex member selections. 
Once defined, users can leverage personal variables any time they are presented 
with the corresponding dimension and database connection.
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In addition, other users can create personal variables, using the same name, 
dimension, and database connection that contain different dimension member 
selections. This technique enables designers to create hybrid reports that feature 
both generic and user-specific content.

Point of View
Point of View User Preferences enable users to insert automatically the dimensions 
and members that are of interest to them into the reports of others.

Point of View expedites the process of member selection in complex dimensions, 
and ensures accurate standardized selections.

Users can also define POV settings using personal variable selections.

Analysis Tools Manager
Hyperion Analyzer provides an interface for managing the creation, activation, 
and order of application of server-based and client-based analysis tools. The 
Analysis Tools Manager is available through the main display panel right-click 
menu.

Analysis Tools further enhance the GUI by expediting comparisons, visually 
organizing data, and emphasizing structures and variances.

Enhanced Traffic Lighting
The Traffic Lighting analysis tool color-codes dimension member values.

Users can base color-coding on a comparison of two dimension members, or on 
fixed limits for a single dimension member. Colors graphically associate member 
values, whether or not they are sorted or ranked, and are commonly used to track 
profitability, highlight exceptions, and automate comparison analyses.

Traffic lighting definitions are maintained as the report is pivoted and changed.

Release 6.0 can color-code data fonts or cell backgrounds with an unlimited 
number of colors.

Calculations
Users can create calculated rows and columns in reports using the Calculations 
Analysis Tool.
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The Calculations Analysis Tool interface enables users to select members, values, 
and operands using a simple point and click interface.

Over 20 mathematical and statistical calculations can be applied to query result 
sets:

● Average

● Percent

● Cumulative

● Percent Difference from Average

● Difference from average

● Percent of Difference

● Divide

● Percent of Total

● Linear Regression

● Rank Ascending

● Maximum

● Rank Descending

● Maximum Value

● Subtract

● Minimum

● Sum

● Minimum Value

● Trend

● Multiply

● Complex Calculations

Show/Hide Only
The Show/Hide Only Analysis Tool provides the ability to include or exclude 
dimension members from the main display panel using any of the following 
criteria:



152 ■

Overview of Advanced Features

Hyperion Analyzer Getting Started

● Member name

● Traffic lighting color

● Data value criteria

It is an excellent way to focus analysis on a discrete set of values.

Hide Only Values
Users can hide data outside prescribed threshold values, using the Hide Only 
Values Analysis Tool. This narrows analysis to a specific range of members using 
their data values.

Hide Only Colors
The Hide Only Colors Analysis Tool enables users to hide rows, columns, and 
objects based on their traffic lighting color. Sophisticated traffic lighting 
definitions further narrow the result set by setting thresholds for all or any 
dimension member values.

Hide Only Members
Users can also conceal or display specific dimensions, members, and member 
combinations using the Hide Only Members Analysis Tool.

Client-side Sorting
The Sorting analysis tool orders specified dimension member values in ascending 
or descending alphanumeric order. Sorting definitions are dynamic and are applied 
as the report is drilled, pivoted, and changed. Client-side sorting is especially 
important for sorting calculated columns or relational result sets.

Retrieve Only Top/Bottom
The Retrieve Only Top/Bottom analysis tool leverages Hyperion Essbase 
server-based sorting and ranking to control the size and order of an OLAP query 
result set. This protects the network server from transmitting, and the client from 
processing, large result sets.

Naturally, the Retrieve Only Top/Bottom analysis tool is central to Top/Bottom 
analysis.
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Restrict Data
The Restrict Data Analysis Tool provides another means of narrowing the return 
set, by requiring that data values be relevant to specific rules and operands.

Applicable rules include these:

● Greater than (>) values in a column

● Less than (<) values in a column

● Equal to (=) values in a column

Applicable operands include these:

● AND

● OR

Data can be restricted by a comparison of another column or by using fixed limits 
on a single column.

Using Hyperion Essbase Features
Server-based features require Hyperion Essbase to execute labor-intensive 
processing, instead of the Hyperion Analyzer client. This improves query speed, 
reduces network traffic, and minimizes the information that Hyperion Analyzer 
must handle.

Edit Data
Users with permission can edit data values with Hyperion Analyzer and write edits 
back to the Hyperion Essbase database. 

After edits have been applied, users can recalculate the database by using the 
client, and measure the impact of changed values.

Suppress Missing Rows, Zeros and Shared Members
Hyperion Analyzer leverages Hyperion Essbase to suppress missing rows, zeros, 
and shared members from the query result set. This prevents irrelevant information 
from being returned, reduces network traffic, and increases query speed.

Users can set suppress missing rows, zeros, and shared members as a user 
preference for all reports, or per individual reports as needed.
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Label Mode
Using Label Mode, Hyperion Analyzer users can select to display member IDs or 
member descriptions, instead of full dimension member names. Even when 
descriptions are displayed, only member IDs are stored in the repository.

Show Selected Member
Hyperion Essbase enables users to preserve the display of selected dimension 
members during Hyperion Analyzer client navigation.

Drill Settings
Because drilling is customizable, drilling can refer to almost any hierarchical 
navigation prompted by double-clicking a dimension label.

Users can customize Hyperion Analyzer drilling in three ways:

● The nature of the hierarchical navigation

● Whether the current dimension members are replaced or augmented

● Whether the drilled dimension member is replaced or augmented

Replace Members with Selections
When the Replace Members with Selections drill setting is activated, existing 
dimensions are replaced with the member selection set generated by drilling.

This process enables users to maintain the current level of report detail while 
navigating along hierarchical lines.

Append Members with Selections
When the Append Members with Selections drill setting is on, existing dimension 
members are retained through the course of navigation. That is, the current 
members are appended with additional selections.

This allows users to control the complexity of their reports.
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Accessing External Information
Relationships between data and reports are as significant as relationships between 
dimensions. Hyperion Analyzer provides numerous methods for relating 
information.

Analyzing Relational Data
A new easy-to-use interface expedites the process of drawing relational data into 
Hyperion Analyzer, and analyzing this data using all the ad-hoc query capabilities 
of the product.

A relational database connection wizard directs users through the process of 
creating their own database connections.

Relational Drill-Through
Hyperion Analyzer enables users to drill through to related relational data from the 
lowest level of the Hyperion Essbase outline, by defining a link on Essbase 
database connections. Users can pass pages, filters, and row limits to focus and 
control the relational query result set.

Essbase Integration Services Drill-through
Essbase Integration Services enables users to organize, format, and present 
relational data as an OLAP cube in Hyperion Essbase.

Hyperion Analyzer users can access Essbase Integration Services report data 
through Hyperion Essbase Linked Reporting Objects by drilling on cells marked 
for EIS drill-through.

Essbase Integration Services drill-through makes relational data available for the 
same sophisticated analysis as conventional multidimensional data.

Linking Reports
Linking refers to navigation between reports and the transmission of member 
selections between reports.

Users can create links to other reports and executables using the Drill > Links 
right-click menu. After being established, double-clicking marked cells passes the 
users display and member selections to the prescribed destination.
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Linking to External Media
Hyperion Essbase Linked Reporting Objects (LROs) enable users to annotate data 
values, by associating external media with a cell.

LROs types include these:

● Text documents

● Objects

● URLs

Double-clicking a cell marked with an LRO displays the associated media in the 
same manner as an HTML hyperlink.

Distributing Analysis
The value of analysis lies in its distribution. The people who produce, analyze and 
use OLAP data must be able to collaborate using OLAP data and tools.

Users can distribute Hyperion Analyzer reports internally and externally, present 
them as HTML Web content, export them to Microsoft Excel, and reference them 
using URLs.

Report Group Properties
Secure distribution paths can be prescribed for Hyperion Analyzer report groups 
using report group properties.

Sharing, and Distributing Report Groups
Report groups are distributed or shared, with Administrator-defined user groups.

Users can share report groups only with user groups to which they belong.

When report groups are shared with user groups, the users in those groups can 
instantly review report group content.

Report Properties
Report properties control report identification and report exploration. Report 
creators can limit the exploration of subsequent users when they save the report to 
a report group. Users can select the following report properties:
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● Hide the report inside the report group.

● Protect the report from being overwritten.

● Prevent users from drilling up or down.

● Prevent users from accessing right-click menu items.

● Prevent user from changing display types.

Reports are automatically distributed as prescribed by report group properties, but 
individual report behavior is controlled by report properties.

Export to Microsoft Excel
As in previous releases of Hyperion Analyzer, users can export report data to 
Microsoft Excel instantly. This enables non-Hyperion Analyzer users to review 
information, and enables report data to be integrated into hundreds of other 
reporting tools.

Export to Clipboard
Users can copy row and column headers to the clipboard using the Export Data to 
Clipboard right-click menu command. This enables Hyperion Analyzer report data 
to be duplicated and distributed to numerous external applications.

Enhanced Printing
Hyperion Analyzer offers advanced print features, including report summary 
pages, print preview, fit-to-page printing, and multidimensional page control. 
These enhancements enable users to print all or specific report aspects based on 
print criteria.

Customizing and Extending Hyperion Analyzer
The Hyperion Analyzer API Toolkit enables Web developers to incorporate the 
Hyperion Analyzer Java Web Client look and feel, and its functionality, into 
custom Web applications.

When developers can rapidly create custom analytical applications using proven 
components, dialogue boxes, and API calls, companies save money and time, and 
improve reliability.
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Information on the Hyperion Analyzer API Toolkit is available in the Hyperion 
Analyzer API Toolkit Developer's Guide. In addition to profiling the API Toolkit, 
its methods, properties, and actions, the Developer's Guide describes samples that 
demonstrate the potential of the API Toolkit.
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Glossary

administrator. An individual who installs and maintains the Hyperion Analyzer 
system, including establishing user IDs, passwords, database connections and 
security. See also System Manager.

Analysis Server. Hyperion Analyzer Analysis Server. An application server that 
distributes report information and enables Web clients to communicate with the 
OLAP server.

asymmetric analysis. A report characterized by groups of members that differ by 
at least one member across groups. There can be a difference either in the number 
of members or in the names of the members.

attribute. A dimension member classification. An attribute can be specified to 
select and group members that have the specified attribute associated with them, 
and to perform calculations and application-specific functions.

attribute dimension. A type of dimension that enables analysis based on the 
attributes or qualities of the members of its base dimension.

axis. A discrete aspect of the two-dimensional report on which multidimensional 
data is displayed, such as filters, pages, rows, and columns.

calculation. The process of aggregating data, or of running a calculation script on 
a database.

calculation script. A set of instructions telling Hyperion Essbase how to 
calculate the values of a database.

cell. A unit of data representing the intersection of dimensions in a 
multidimensional database. Also, the intersection of a row and column in a 
spreadsheet.

chart. One of the three report display types. Chart reports also have a chart type 
property set for them. Charts are created using Hyperion Analyzer.
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child. A member that has a parent above it in the database hierarchy. A child may 
have siblings (peers) that exist at the same level of the database hierarchy.

client. A client interface, such as Hyperion Analyzer, or a workstation on a local 
area network.

column. A vertical display of information in a grid or table. A column can contain 
data from a single cell, derived data from a calculation, or textual information. 
Contrast with row.

database. A repository of data within Hyperion Essbase that contains a 
multidimensional data storage array. Each database consists of a storage structure 
definition (outline), data, security definitions, and optional scripts.

database connection. A user-friendly database alias used instead of a long 
database identifier (server name, application name, and database name) that 
enables database references to be more portable.

data source. A named client-side object connecting report components to 
databases, using database connections, queries, and other components.

descendant. Any member below a parent in the database outline.

Desktop. An automatically generated report that dynamically presents buttons 
that enable groups of reports to be accessed with a single click.

dimension. A data category that is used to organize business data for retrieval and 
consolidation of values. Each dimension contains a hierarchy of related members 
grouped within it.

display type. One of three Hyperion Analyzer formats saved to the repository: 
spreadsheet, chart, and Pinboard.

external authentication. The ability to log in to Hyperion applications using user 
information stored outside the application itself; user names and passwords are 
instead managed in a corporate authentication provider such as LDAP or 
Microsoft Windows NTLM.

hierarchy. A set of multidimensional relationships in an outline, often created in 
a tree format.

implied share. A member with only one child, or a member with multiple 
children of which only one child is consolidated. For this reason the parent and 
child share the same value.

intersection. A unit of data representing the intersection of dimensions in a 
multidimensional database. Also, a worksheet cell.
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JDBC. Java Database Connectivity driver. Client-server communication agent 
between Java-based clients and databases.

linked reporting object (LRO). An external file that is linked to a data cell in a 
Hyperion Analyzer report.

member. A discrete item that forms part of a dimension.

missing data. A marker indicating that data in the labeled location either does not 
exist, contains no meaningful value, or was never entered.

multidimensional database (MDDB). A method for referencing data through 
three or more dimensions. An individual record is the intersection of a point for a 
set of dimensions.

multithreading. A client-server process that enables multiple users to work on 
the same applications without interfering with each other.

online analytical processing (OLAP). A multidimensional, multi-user, 
client-server computing environment for users who need to analyze consolidated 
enterprise data in real time. OLAP systems feature drill-down, data pivoting, 
complex calculations, trend analysis, and modeling.

parent. A member that has subordinate members below it in the hierarchy.

personal variable. A means by which users define and name complex member 
selections.

pinboard. One of the three report display types. Pinboards are graphic reports, 
composed of backgrounds and interactive icons called Pins. Pinboards are created 
using Hyperion Analyzer Design Tools.

point of view (POV). A means by which users automatically insert dimensions 
and members that are of interest to them into the reports of others.

pins. Interactive icons placed on graphic reports called pinboards. Pins are 
dynamic. They can change images, and traffic lighting color based on the 
underlying data values and analysis tools criteria.

report. A Hyperion Analyzer display of selected multidimensional cube 
dimensions and members. A report is both the content and the format of the 
display. After it is saved to the repository, a report becomes a multipurpose file that 
users can display in numerous formats.

report group. A group of Hyperion Analyzer reports.

repository. A set of relational database tables for storing report definitions and 
Hyperion Analyzer system information.



162 ■

Glossary

Hyperion Analyzer Getting Started

role. A user type label. Roles give or withhold the permissions needed for various 
Hyperion Analyzer tasks.

row. A horizontal display of information in a grid or table. A row can contain data 
from a single cell, derived data from a calculation, or textual information. Contrast 
with column.

query. A component of the data source. Queries are SQL statements submitted to 
the database, which return multidimensional intersection result sets.

server. A multi-user database server that accesses data values based on the 
intersection of dimension members.

single sign-on. The ability for a user to access multiple Hyperion Applications 
after logging on just once using external credentials.

spreadsheet. One of the three report display types. Spreadsheets are tabular 
reports of rows, columns and pages, created using Hyperion Analyzer.

subset. A group of members selected by specific criteria.

substitution variable. A variable that acts as a global placeholder for information 
that changes regularly. You set the variable and a corresponding string value; the 
value can be changed at any time.

System Manager. An individual who installs and maintains the Hyperion 
Analyzer system including establishing user IDs, passwords, database 
connections, and security. See also administrator.

toolbar. A series of shortcut buttons providing quick access to the most 
frequently used commands.

traffic lighting. Color-coding of report cells, or Pins based on a comparison of 
two dimension members, or on fixed limits. Traffic lighting definitions are created 
using the Hyperion Analyzer Traffic Light Analysis Tool.

Uniform Resource Locator (URL). An address for a resource in the World 
Wide Web, such as a document, an image, downloadable files, a service, or an 
electronic mailbox. URLs use a variety of naming conventions and access 
methods, such as HTTP, FTP and Internet mail. URLs can point to files on a local 
network drive, or to reports in the Hyperion Analyzer repository.
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Index

A
administration tools, Hyperion Analyzer, 20
administrators, 23
administrators, system, 23
advanced users, 24
analysis server, Hyperion Analyzer, 20
analysis tool

calculations, 150
hide only, 151
hide only colors, 152
hide only members, 152
hide only values, 152
restrict data, 153
retrieve only top/bottom, 152
show/hide only, 151
sorting, 152
traffic lighting, 150

api toolkit, 20

C
calculations analysis tool, 150
chart properties, 56
charts, 50, 77
clipboard, 157
clipboard, copy to, 157
clipboard, export to, 157
column sizing, 56
columns and rows, suppress missing, 153
controlling report exploration, 156
copy to clipboard, 157

D
data display options, 56
data, relational, 155
design report mode, 40
desktop, Hyperion Analyzer, 35, 63
developers, 22, 25
distributing reports, 156
distribution, report, 156
drill linking, 55, 82
drill settings, 154
drilling, 54, 81
drill-through, his, 155
drill-through, relational, 155

E
edit data, 153
edit data mode, 39, 67
enhanced printing, 157
evaluators, 22
export to clipboard, 157
export to microsoft excel, 157

F
filter panel, 43, 70

H
hide only analysis tool, 151
hide only colors analysis tool, 152
hide only members analysis tool, 152
hide only values analysis tool, 152
his drill-through, 155
Hyperion Analyzer
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about, 19
advanced features, 145
architecture, 20
components, 19

Hyperion Analyzer Administration Tools, 20
Hyperion Analyzer Analysis Server, 20
Hyperion Analyzer Desktop, 35, 63
Hyperion Analyzer HTML Web Client

modes, 62
overview, 20
starting, 61
user interface, 62

Hyperion Analyzer Java Web Client
overview, 20
starting, 33

Hyperion Analyzer Windows Client, 20

I
information consumers, 22, 25
information panel, 41, 68

L
label mode, 154
Levels, 29
linked reporting objects, 156
linking reports, 155
logging off, 86

M
main display panel, 41, 68

resizing, 72
right-click, 44

microsoft excel, 157
microsoft excel, export to, 157
microsoft excel, send to, 157
missing columns and rows, suppressing, 153
mode

design report, 40
edit data, 39, 67
label, 154
normal, 36, 64

moving, 53, 81

N
normal mode, 36, 64

O
online guide

searching, xvii
options, data display, 56
options, spreadsheet, 55

P
page control panel, 43, 69
paging, 53, 80
personal variables, 149
pinboard properties, 56
pinboards, 51, 78
point of view, 150
power user, 22
print, 157
printing, enhanced, 157
printing, report, 157
properties, chart, 56
properties, pinboard, 56
properties, report, 156
properties, report group, 156

R
relational data, 155
relational drill-through, 155
report data, editing, 85
report designers, 24
report display types, 76

changing, 51, 79
overview, 48

report distribution, 156
report exploration, controlling, 156
report group properties, 156
report manager, 71
report printing, 157
report properties, 156
reports

creating, 107
creating a custom, 129
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creating in HTML Web Client, 84
distributing, 58, 83
formatting, 55
navigating between, 48, 76
opening, 47
passing to Java Web Client, 86
printing, 86
saving, 57, 82

reports, distributing, 156
reports, linking, 155
repository, 19
restrict data analysis tool, 153
retrieve only top/bottom analysis tool, 152

S
sample report group

tour, 87
send to microsoft excel, 157
settings, drill, 154
sharing, 156
show selected member, 154
show/hide only analysis tool, 151
sizing, column, 56
sorting analysis tool, 152
spreadsheet options, 55
spreadsheets, 49, 77
suppress missing columns and rows, 153
swapping, 53
system administrators, 23

T
traffic lighting analysis tool, 150
types, report display, 76
types, user, 22

U
user interface

hiding components HTML Web Client, 71
hiding components in Java Web Client, 44
setting style in HTML Web Client, 73

user types, 22

V
variables, personal, 149
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